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Abstract 
Previous studies have entertained the prospect of having 3D models substitute for their dry bone 

originals in osteological analysis. The objective of this study was to contribute to qualifying to 

what extent this may be possible given current technology. To this purpose, rather than choosing 

just a quantitative and purely technical method for evaluating models, as has been the norm in 

previous studies, a qualitative method was also applied where the visual identifiability of the 

traits was taken as the standard. A cranium and a metatarsal bone were chosen as case studies, 

and three types of models were created of each specimen – a scan-based model, an image-based 

model and a model combining geometry from scans with textures from photos. The relative 

identifiability of the traits on the different models was graded and compared, and the factors that 

contributed to the results discussed. The study found that while 3D models may hold some 

advantages over photo documentation as substitutes to originals in osteological analysis, 

primarily due to preserving much of the originals’ geometry, the technology also suffers some 

disadvantages, notably that the textures’ image quality often fall short of photos, especially when 

superimposed on distorted geometry generated from scans. It can also prove difficult to create 

models capable of representing all parts of their originals equally well without making the 

models excessively heavy. Furthermore, the study showed that some morphological traits were 

more difficult to digitize and thus less identifiable on 3D models than others, and that 

qualitatively evaluating 3D models is a complex and challenging task. These results challenge 

assertions about the capabilities of 3D models in previous studies, and suggests that establishing 

a common standard for evaluating digital models, such as the identifiability of osteological traits 

introduced here, is a desirable development in digital osteology. 
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1. INTRODUCTION 

1.1 Background 
The overall evaluation of 3D representations of bones by the standards required to allow 

osteological analysis has so far received little attention in osteological research. Rather than 

qualitatively evaluating the three-dimensional models’ capabilities to be utilized in osteological 

analysis, systematic evaluation of 3D models of bones tends in most cases to rely on quantifiable 

technical standards (e.g. surface quality, metric accuracy and texture resolution), or to be 

performed to the purpose of evaluating 3D digital methods more so than to evaluate the 3D 

models themselves (e.g. Karell et.al. 2016; Katz & Friess 2012; Brzobohatá et.al. 2012). In the 

studies I have come across where osteological expertise is drawn upon as a standard to evaluate 

3D models, this has generally been a cursory effort, and transparency into this process and its 

criteria has been limited. Some studies claim to have enlisted the collaboration of observers with 

osteological expertize to evaluate models, but do not describe the evaluation process (e.g. Wilson 

2013; Bibliowicz et.al. 2011, p. 8). Other studies premise their methodology on the close 

correspondence between 3D models and their dry bone originals, but does not acknowledge that 

an evaluation process took place to ascertain such correspondence (Šplíchalová et.al 2015; Jurda 

& Urbanová 2015; Errickson et.al. 2014). To my knowledge, it is only in highly focused studies 

that investigates the possibility of applying specific osteological methods or identifying specific 

morphological traits on 3D models that we find sustained and transparent efforts to evaluate the 

capabilities of models to substitute for their physical originals in osteological analysis (e.g. Villa 

et.al. 2013). To my knowledge, there are no standards for qualitatively evaluating the capabilities 

of 3D models to represent multiple morphological traits. 

The hitherto dearth of studies concerned with the overall evaluation of 3D models of bones by 

the standards required to allow osteological analysis leaves something to be desired, especially 

so given that pioneering studies that discuss the potentials of digital osteology have regularly 

entertained the prospect of producing 3D models which can substitute for skeletal remains in 

context of osteological analysis. This would be useful in educational contexts, in global 

mediation of rare osteological material, or when physical bones are to be documented prior to 

repatriation or invasive procedures (Weber 2015; Kuzminsky & Gardiner 2012; Wilson 2014; 

Rohland & Hofreiter 2007, p.1758f). If we are to better define to what extent, and under what 
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circumstances, such potentials are achievable given current and near future technology, we need 

more studies that undertake rigorous and transparent evaluations not only of the application of 

individual osteological methods to 3D models of bones, but also of the overall model and its 

capabilities to simultaneously represent several morphological traits. It is not enough to evaluate 

the capability of individual 3D modeling method or to identify an individual trait on 3D models, 

it is also desirable to evaluate the extent to which one may reproduce the process and results of 

an osteological analysis in the digital medium. 

At the outset of this study, I may predict on the one hand (i) that digital 3D models have some 

capabilities to serve as substitutes to their physical originals in osteological analysis, although 

they remain to be fully qualified and developed by scholarship, and on the other (ii) that not all 

osteological methods and techniques will be translatable into the digital medium. In osteological 

analysis, osteologists identify a wide range of morphological traits on bones – e.g. porosities, 

deformities, bony projections and erosions – using various kinds of empirical evidence – e.g. 

visual, tactual, aural – as acquired through numerous methods of sense experience – e.g. rotating 

the bone to better examine deformities, palpation to examine the texture of the bone, or listening 

to the sound the bone makes as it is palpated or put down on a table surface (e.g. Seik 2015). 

Given this complexity, the prospect of conducting osteological analysis of 3D models faces a 

number of challenges, although it is also bound to provide some new potentialities (e.g. new 

tools and methodologies), both compared to traditional photo documentation, casting and 

molding, and conventional dry bone osteological analysis (e.g. White et.al. 2012, p. 341-342, 

351-352). Needless to say, the capabilities of digital models to be used in osteological analysis 

are limited to visual empirical evidence, and can thus never fully substitute for dry bone. 

Nevertheless, visual evidence remains the most important mode of empirical evidence in 

osteological analysis, and the capabilities of 3D models to substitute for their originals in visual 

osteological analysis remains a relatively unexplored subject in osteological research.  

 

1.2 Aims and Research Questions  

The primary aim of this thesis is to contribute to current osteological research by evaluating and 

discussing digital 3D representations of human bones and their morphological traits and to 
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evaluate the capabilities of digital models to substitute for their originals in the context of visual 

and metric osteological analysis. To this purpose, the thesis will evaluate a human cranium and a 

metatarsal bone based on their overall properties – including the quality, resolution, and noises 

(errors) on the geometry (surface) and textures (color information from images) of the 3D 

models, but most importantly the quantifiable (metric) and qualitative (non-metric) 

correspondence of the digital representations vis-à-vis the morphological traits of their physical 

originals. Affordable 3D modeling hardware and software as well as conventional osteological 

methods will be utilized to produce, process, analyze, compare, and evaluate the 3D 

representations. I will also discuss the role of the osteologist both as the digitizer and interpreter 

as I take on both roles. To guide this process, I will investigate the following research questions: 

- How well can the 3D models of the cranium and metatarsal bone represent the 

morphological traits of their originals? 

 

-  In these case studies, what factors and issues have impacted and/or contributed to the 

identifiability of the morphological traits on the 3D models? 

 

I will answer the first question as the osteologist and the second as the digitizer. While this 

study’s stated purpose is to present an overall evaluation of the digital models, space and time 

constraints dictates that its scope must be delimited to number of morphological traits of 

osteological significance. On the cranium, the morphological traits that will be analyzed are the 

changes associated with cribra orbitalia on the orbital roofs, the length/size of the mastoid 

process, the breadth of nasal cavity, and the coronal and lambdoid sutures. On the metatarsal 

bone, the callus formation (bone growth) from a healed fracture and the root impressions, surface 

damage caused by roots of plants are of interest. These traits are under review in chapter 2. 

 

1.3 Research History 

1.3.1 Physical and Digital 3D Modeling 
Prior to the introduction of digital 3D modeling, molding and casting were methods used to 

create physical 3D representations (i.e. models) of bones, teeth, and fossils (Slick 2016; Weber 

2015, p.24-27; Friess 2012). A mold is a negative impression usually made from a flexible 

material, while a cast is created when the negative impression within a mold is duplicated. The 
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negative impression within a mold is often filled with a fluid material that hardens into a replica 

representing the shape and external surface of an object. Replicas are used for various purposes – 

for 3D documentation of the object under study, for educational purposes as reference material, 

for mediation in communicating findings with colleagues and the general public, and as a 

substitute for originals in comparative research and when conducting invasive procedures such as 

slicing into cross sections (White et.al. 2012, p.351-352; Mann & Monge 2012 p.97-98, 1987). 

Today, replicas are commercially available from various sources such as Bone Clones and Skull 

Unlimited where high quality replicas of human and animal fossils and bones can be purchased 

(Bones Clones 2016; Skull Unlimited 2016). Replicas are also used in the analysis of surface 

details such as cut-marks, dental-wear and taphonomic features (Bello et.al. 2011; Camarós et.al. 

2016; Purnell 2003).    

There are various casting and molding techniques using a wide range of materials. The F.O. 

Barlow molding technique used to create the plaster-of-Paris molds of hominid fossils in the 20´s 

and 30´s was one landmark in the field. These molds were often made of many pieces, waxed 

and keyed to each other to ease the removal of plaster from often fragile fossil specimens. Latex 

rubber molds were later made from the plaster-of-Paris originals, resulting in thousands of fossil 

casts (e.g. of the original Neanderthal finds) that were distributed to hundreds of museums, 

colleges and universities. David Gilbert developed workable procedures for employing synthetic 

silicone molding rubbers, and a variety of plastic casting resins used to create molds of the most 

famous human and primate fossils (e.g. the Taung child from South Africa).  Nearly 16 000 high 

quality casts of fossil remains were created using Gilbert´s techniques and were distributed to 

scientists and research and teaching institutions throughout the world. Alan Mann and Janet 

Monge also contributed to the study of casting and molding by introducing the concept of pattern 

making. A pattern, usually of epoxy, is like a cast in that it is a positive impression made from a 

mold, but it is a positive not only of the hollow in the mold that replicates the fossil, but also of 

the complete mold section. Thus, a pattern is a positive of a molded object that maintains the 

form of the mold as well as the form of the bone. The reproduction of replicas from replicas 

became prominent primarily due to limited access to the original materials, especially fossils, but 

also due to concerns about excessive handling causing damage to the original material (Mann & 

Monge 2012, p.97-105; 1987).  
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Careful consideration is required when choosing techniques and materials for casting and 

molding. For example, room temperature vulcanization (RTV) silicone rubber is practical 

compared to plaster and has, in combination with high-viscosity epoxy, the ability to generate a 

cast with significant microstructural detail (around 5000x magnification). Through an 

experiment where they created molds of a roe-deer mandible with cut-marks and studied the cut-

marks on the bone and on the molds using an Alicona microscope, Bello et.al. (2011) 

demonstrates that silicone rubber molding and epoxy casting can be applied to produce replicas 

of fossils with microscopic details. However, silicone rubber and epoxy resins are generally 

more expensive than plaster, and their application can affect the object being molded. For 

example, silicone rubber can penetrate surface foramina on bones. When the mold is peeled off, 

the silicone rubber breaks and remains in the holes, thus permanently modifying the surface 

anatomy of the bone. Furthermore, it leaves various chemical residues, some of which penetrate 

into the object. Epoxy resins are rigid, durable and long lasting. However, their application 

releases a byproduct chemical that can penetrate the silicone mold, degrading it and ultimately 

destroying its elasticity, potentially resulting in an inaccurate cast and decreasing the number of 

times the mold can be used (Bello et.al. 2011; Mann & Monge 2012 p. 91-94;1987).  

Issues with the application of casting and molding techniques and materials not only affect the 

fossils and bone specimens, but also the accuracy of casts and molds. With current casting and 

molding techniques and materials, casts and molds that can accurately represent fossils and 

bones seemed to be a distance goal. However, even when better and more non-invasive 

techniques and materials are introduced, replicas can never fully substitute for actual bones and 

fossils as completely accurate casts can never be generated and the internal morphology of 

fossils and bones is lost. In addition, examiners unfamiliar with the original can also be misled 

by casts lacking features that may only be identifiable with the reference to the original (White 

et.al. 2012, p. 341; Monge & Mann 2005, p.99-101). Misinterpretations based on inaccurate 

observations and measurements on casts as well as photographs have occurred and been noted by 

osteologists (see Clarke & Howell 1972). 

3D modeling on the other hand is the process of creating and shaping three-dimensional digital 

representations of bones and teeth. Digital 3D models are mathematical representations of the 

objects (real or imagined) in 3D space. There are various types of 3D modeling techniques, the 
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most common in osteology being volume and surface modeling (Slick 2016; Weber 2015, p.24-

27; Friess 2012). Volume scanning is one example of volume modeling techniques. The most 

common volume scanning technique used in osteology is computed tomography (CT). It’s a non-

destructive method where medical or industrial CT scanners are used to digitize and analyze the 

morphology and microarchitecture of bones and teeth. The CT scans obtained from volume 

scanning are made of many radiographic images from multiple angles, 2D images (virtual slices) 

that are combined in stacks to form volume data (virtual thickness of the object) that can be 

viewed in 3D (Bekvalac 2016, p. f; Harvig et.al. 2012, p.3f). Volume scanning is used for 

various purposes, but its primary advantage is that it allows for analysis of the internal structure 

and volume of the specimen (e.g. Wollaston 2015; Galea 2015; Benazzi et.al. 2014). In terms of 

limitations, access to such scanners is often limited, and osteologists have often partnered with 

scientists in the field of medicine to gain access to expensive 3D imaging equipment. CT 

scanners are usually stationary due to their size, weight, immobility and harmful radiation. 

Furthermore, operating CT scanners requires specialists and until recently, the data files could 

only be opened in expensive software that also requires specialized training to operate (Weber 

2014; Kuzminsky & Gardiner 2012, p. 2744-2745).  

Like volume scanning, digital surface modeling is a non-invasive (non-contact) method which 

only captures the surfaces of specimen, resulting in a surface model (Friess 2012; Bekvalac 

2016). The most common type of surface model is a polygon model or “mesh”. These kinds of 

models are built from a structure with three basic elements – vertices, edges and faces. A vertex 

(singular form of vertices) is a point or position in 3D space, an edge is the straight line that 

connects two vertices, and a face is the area that formed between the edges that connect at the 

vertices and that comprise the geometry of a 3D model. Textures or color information from 2D 

images can be applied to the model to create a more realistic-looking model (Slick 2016).  

In recent years, more affordable scan-based modeling (SBM) and image-based modeling (IBM) 

have been utilized in osteology. In SBM, low-cost 3D laser scanners can be used to scan an 

object in different angles, obtaining 2D scans that can be virtually combined into a 3D scan-

based model (Kuzminsky & Gardiner 2012; Friess 2012). IBM (often called close range 

photography) on the other hand is a recent addition in the osteological toolbox, and has yet to be 

fully established in the field. The method is used to generate an image-based model from 
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overlapping images of an object, taken from multiple positions using a digital camera. The 

images are imported into a software that processes digital images into an image-based model 

(Matthews 2008, p. 11; Walford 2007). Compared to surface scanning and other 3D modeling 

techniques, IBM is more affordable and portable. However, both techniques require a powerful 

computer, a user with 3D modeling knowledge and experience and, in case of high quality 3D 

models, plenty of digital storage space. Comparing surface scanning and IBM, the latter is the 

cheaper and more portable alternative, although accurate scale can be obtained automatically 

with SBM, thus requiring no additional scaling. 3D models created through IBM on the other 

hand require manual scaling using external software such as MeshLab, as scaling cannot be 

performed in Agisoft PhotoScan without a Pro license (Weber 2014, 2015; MeshLab 2014; 

Agisoft PhotoScan 2016; CHI 2015; Sulaiman 2012).  

3D modeling also allows for creating physical 3D representations analogous to molds and casts 

through 3D printing techniques such as stereolithography (Hublin 2007, p. 817f). Digital and 3D 

printed models are largely used for the same purposes as casts and molds. Discussion of 3D 

techniques’ additional advantages and potential applications are an increasingly hot topic in 

recent studies. By comparison, 3D models of bones are more practical than casts of bones and 

fossils as the former can be stored digitally, thus requiring less physical storage space. With 3D 

digital modeling, skeletal and dental remains can be made more accessible to a wider public in 

the classroom, the lab and the field through online resources. Furthermore, 3D models can be 

modified and manipulated reversibly and indefinitely, thus enabling simulation and testing of 

various hypotheses. Other advantages of 3D modeling include that volume modeling enables 

analysis of the internal structure and volume of skeletal and dental remains, something which is 

impossible with casts as they, similarly to surface scanning, only can represent the surfaces of 

the object. Nevertheless, volume models often only provide low-resolution representation of the 

internal and especially external surfaces (Weber 2015; Friess 2013; Kuzminsky & Gardiner 

2012; Hublin 2007). 

1.3.2 The Application and Evaluation of 3D techniques in an Osteological 

Context 

3D modeling is applied in many sectors ranging from engineering and manufacturing to 

osteology. As stated previously, it can be applied for many purposes and offers some new 
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possibilities. However, its application in osteology still lags behind other fields. In this section, 

the application of 3D modeling in human osteology and osteology-related contexts. Some 

examples are interdisciplinary or primarily situated in other fields as osteological material is also 

studied in fields such as medicine, forensic science and archaeology. Among these fields, 

osteology often overlaps with archaeology as osteological remains are excavated in 

archaeological studies (Weber 2014).  

In the archaeological excavations at the Neolithic site in Çatalhöyük, 3D modeling techniques 

have been applied for many years (2010- 2016 and onward). 3D models of burials that 

prominently contained skeletal remains along with the remains of house structures were created 

through laser scanning and image-based modeling and integrated with other digital techniques 

such as Geographic Information System (GIS) in order to document, map and integrate 

archaeological and osteological contexts in the study and interpretation of the excavated burials. 

GIS integrated interface allows the archeologists to collate greater data sets, something that helps 

in interpreting the lifestyles of the inhabitants, their social structure and their mortuary customs. 

In addition, the use of 3D modeling and 3D models provides opportunities to continue the 

studying the material after excavation has concluded (Haddow et.al. 2016, 2014; Forte et.al. 

2015; Berggren et.al. 2015; Knüsel et.al. 2013). 

Increasing numbers of museums and other heritage institutions have implemented digital media 

and 3D technologies to digitally document, conserve and mediate their collections to a wider 

audience (Younan & Treadaway 2015). Projects such as Digitised Diseases and From Cemetery 

to Clinic are online resources that mediate skeletal remains with pathological changes, whereof 

many are rare specimens, in the form of high quality 3D models. These open resources are 

available to anyone interested, and are intended to be used primarily for educational purposes 

and as a digital reference. The digitization of the skeletal remains was also an effort to reduce 

repeated handling of the physical bones, something that can cause damage (Wilson 2014; 

Digitised Diseases accessed 2016-02-10; Buckberry et.al. 2012; University of Bradford 2013). 

There are also online mediation platforms such as Sketchfab where students, researchers and 3D 

modeling enthusiasts can share their 3D models and find and access interactive virtual reality 

(VR, e.g. computer-simulated historical environment). For example, the Virtual Curation 

Laboratory of Virginia Commonwealth University makes use of this platform to share some the 
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artifacts of their archaeological and osteological collection (Sketchfab: Virtual Curation Lab 

2016; Means 2016). Apps for mobile and computer tablets are also created for educational and 

mediation purposes. One example is Dactyl, a commercial 3D viewer app with photo-realistic 

models of actual scanned human skeletal elements that aids in the identification, siding and 

pathological analysis of osteological material. With this app, students have access to a digital 

reference and study tool in their pockets (Atkins 2015). The app Skin & Bones was used in the 

Bone Hall exhibition of the Smithsonian Natural Museums of Natural History. The visitors can 

download the app to experience the exhibition in a more interactive manner. This exciting 

technology superimposes a virtual world onto the physical one and was known as Augmented 

Reality. For example, looking at a vampire bat skeleton through a tablet with a camera, one can 

see the specimen come to life as it pulls itself off the mount and flies away (Smithsonian 2016; 

Natural Museums of Natural History 2016).  

3D modeling also enables digital reconstruction of incomplete bones in a non-invasive manner. 

Digital fragments of bones can be modified and adjusted (rotated, translated and scaled) to any 

position necessary, mirrored to compensate for missing paired parts or even modified to simulate 

changes that affected the skeletal remains (Weber 2015, Cramblitt 2013; Senck et.al. 2013; 

Benazzi et.al. 2010). For example, 3D models of cranium fragments can be digitally glued 

together and the missing fragments replaced to reconstruct the cranium to its original state 

(Urbanová et.al. 2014). Taking a step further, one can digitally simulate the face tissues, muscles, 

skin, facial organs, hair, and facial features to reconstruct the face of a historical figure such as 

Richard III. State of the art digital 3D modeling and 3D printing techniques combined with 

conventional reconstruction painting has used in the reconstruction of the king´s face. Starting 

with the data gathered from a CT scan of the skull, the layers of muscle that compose the face 

were built up. Data about the average thickness of muscle layers and facial features was used to 

ensure that the model was a fair estimate given the age, gender and race of the individual. 

Furthermore, a plastic 3D printed model based on the 3D model was produced using a technique 

called stereolithography where layers of the polymer are built up in the desired shape and set 

using ultra violet light. The 3D printed model was carefully painted to give it a life-like feel and 

the eyes were mounted internally using wax and glue. Finishing touches like the style and color 

of Richard’s hair and hat were taken from near contemporary portraits of the king (Feigl 2013; 
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The British Museum 2014). An interactive digital 3D model of the grave of Richard III was also 

created through IBM and is available in Sketchfab (Sketchfab 2016).   

3D modeling has also been applied in morphological analysis where analysis of morphological 

traits (e.g. features and changes associated to age) that are usually conducted on physical bones 

were analyzed on 3D models of bones. Furthermore, metric analysis has also been conducted on 

3D models of bones where traits such as the length of the femoral bone was measured to assess 

height and sex (Weber 2015; Decker et.al. 2011; Šplíchalová et.al. 2015; Dias et.al. 2015).  

3D modeling was also used in combination with Geographic Information System (GIS) in the 

recently developed method called Virtual Taphonomy. In the study introducing the method, 

taphonomic processes such as gnaw marks caused by rodent incisors were documented through 

3D modeling on some of the bones from the excavation of Sandby Ring Fort on Öland. These 

models, along with 3D models of house structures and the trenches containing human skeletal 

remains, were created and integrated into a GIS database along with the results of the 

osteological analysis of bones and information about other archaeological findings and contexts 

excavated and recorded on different occasions. The study demonstrated that the method enabled 

deeper understanding of the taphonomic agents and facilitated more detailed and holistic 

interpretations of the skeletal remains than would be possible with conventional documentation 

methods. It also improved overview of and transparency into the entire research process from the 

field to post-processing and interpretation (Wilhelmson & Dell ‘Unto 2015). 

3D scanning also allows the documentation and analysis of hidden or inaccessible parts and 

morphological traits of skeletal remains. For example, in the excavation of Pompeii, the casts 

containing the remains of the afflicted victims of the Vesuvius eruption were digitized using CT 

and handheld scanners to create detailed 3D models that digitally preserve the casts, and also to 

analyze the remains that lies beneath, revealing the delicate skeletal and dental remains, some 

even showing dental cavities indicating caries, which in turn indicates high carbohydrate diet 

(e.g. Sheldon 2014; Woollaston 2016). 

3D modeling has also been applied in another recently developed method that could be useful for 

identifying and sorting commingled human remains. Mesh-to-mesh value comparison (MVC) 

was based on pair-matching where the geometry of 3D models of pair bones (e.g. humeri) are 

https://www.researchgate.net/profile/Ivana_Splichalova
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digitally compared (by manual and automated means) to produce a single value to indicate their 

level of similarity, and thus being able to identify bones that belong to the same individual. 

Currently, there are few methods available to accurately sort comingled remains, something that 

usually is a challenging and time consuming task. In Karell et. al., two versions of the method – 

one manual and the other automated – were created and tested to examine how well they could 

accurately pair-match the 45 3D models of humeri. In the manual version, the left humeri were 

digitally compared to right humeri. Two humeri (left and right) at the time were compared by 

roughly lining up the two on top of each other. The fine alignment function was then applied to 

obtain the mesh-to-mesh value which reveals how much they match or differ, thus allowing 

matching. In the automated version, all the models (left and right) were automatically compared 

with each other in a single folder to obtain the mesh-to-mesh value and thus the match of humeri 

pairs. The results indicated that the mesh-to-mesh value comparison method is overall a powerful 

tool for accurately pair-matching commingled skeletal elements, although the automated version 

still needs improvements (Karell et.al.2016).  

In another study, semi-automatic mesh-to-mesh comparison tools were evaluated by applying the 

method to a sample of 40 human crania of known sex and ancestry, digitized via image-based 

modeling and laser scanning. The models were registered and quantified in the freely available 

software FIDENTIS Analyst. The program quantifies dissimilarity pairwise on basis of closest 

vertex-to-vertex distances. The differences were further reinforced by visualizing local variations 

on models using color scalar maps. For further evaluation, the results were compared with those 

provided by 3d-id software, a 3D coordinate database of modern cranial remains of known 

background in terms of sex and ancestry etc. (Urbanová &. Jurda 2015; 3d-id 2014). 

A small number of studies have taken a qualitative approach to evaluating models, although 

regrettably, there is little transparency into the standards of the evaluation process. Furthermore, 

many of these studies tend to focus on the evaluation of 3D digital methods and their ability to 

produce models created for specific purposes. Systematic evaluation of 3D models of bones 

tends in most cases to rely on quantifiable technical standards (e.g. surface quality, metric 

accuracy and texture resolution), and to be performed to the purpose of evaluating 3D digital 

methods vis-à vis each other more so than to evaluate the 3D models themselves vis-à-vis their 

originals. To my knowledge, it is only in highly focused studies that investigates the possibility 
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of applying specific osteological methods or specific osteological traits on 3D models that we 

find transparent efforts to evaluate the capabilities of models relative to their physical originals. 

Below are some examples of studies that evaluate and/or compare 3D modeling techniques, 

explore their advantages and limitations, and in some cases apply osteological methods in order 

to evaluate the capability of 3D models to represent certain morphological traits of bones and 

thus their potential for application in morphological analysis. 

Bibliowicz et.al. (2011) evaluated 3D models of bones (e.g. a tibia) that were created through 

laser scanning for use in “osteological and morphometric analyses as well as biomechanical 

simulation” (p. 3). A number of the models were visually evaluated by expert anatomists to 

determine if any of the anatomically relevant landmarks were missing or altered. Subsequently, a 

3D printout of one of the models underwent the same procedure. The general consensus was that 

the models and the printout reproduction could accurately represent the original bone (2011, 

p.7f). Regrettably, the study does not go into the details of the evaluation process. While the 

study’s aims and methods appears to have significant overlap with the present thesis, the lack of 

transparency into the evaluation process and its criteria makes it difficult to relate its results to 

other studies. Furthermore, there are also the unaddressed issues with evaluating a model based 

on a printout, as it is to be expected that there will be significant differences between a 3D model 

and its physical printout version. Depending on the 3D printer and the material used for printing, 

the quality of the printout model could vary. Features on the surface of a bone could be present 

on the 3D surface of a 3D model but absent or distorted in the printout model due to the 

limitations of the 3D printer (e.g. objects with fine details) and the quality of material (e.g. glossy 

and smooth plastic) (Grieser 2015; Allen 2013). That no such issues are reported or discussed by 

Bibliowicz et. al. was suspect, but the lack of transparency into the evaluation process makes 

reviewing their results very difficult. 

Brzobohatá et.al. (2012) compared two different methods to scan and generate 3D surface 

models of 5 frontal bones. Models created through laser scanning were compared with those 

acquired through CT scanning with regard to their overall surface deviation to evaluate their 

accuracy and the benefits which come with their application. The study concluded that there 

were minimal differences in the surfaces of the models. Subsequently, the surface models were 

visually analyzed based on their surface morphology (e.g. concavities such as those above the 
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supraorbital margins) and relative to the surface morphology of the real frontal bones. The 

models generated from CT scanning were more accurate and thus corresponded better to the real 

surface of the bones than those acquired through laser scanning which was not sensitive enough 

to capture fine details of the surface of the real bones. However, the comparative methodology 

by which the models were evaluated, and the relationship to original bone was barely touched 

on.  

Katz and Friess (2012) conducted a study to assess image-based modeling as an alternative to 3D 

scanning for the collection of external morphometric data (measurements) from bones in an 

anthropological context. The precision and repeatability of the method was tested by comparing 

3D models of human crania generated through image-based modeling to those generated through 

3D surface scanning. Precision was assessed by comparing the surface areas and landmark 

configurations on the models of the image-based modeling and laser scanning. The surface areas 

were computed for the parietal and nasal bones and for the landmark configurations the 

coordinates of 16 standard anatomical landmarks were recorded on the models. These landmarks 

were also recorded on the human crania. Overall, the deviation between the models based on the 

landmarks was low. While Katz and Friess compares two methods and evaluates their relative 

accuracy quantitatively, my methodology is qualitative, and does not primarily evaluate the 3D 

digital methods vis-à-vis each other, instead making reference to the original and evaluating the 

ability to discern the osteological traits on the models. In this thesis, model v. model comparison 

is a secondary step. 

Errickson et.al. (2014) discussed the possibilities in implementing 3D models of bone evidence 

in the courtroom as bone evidence from a traumatic scene cannot be taken into the court due to 

its sensitive nature. Photographic images are usually used as a proxy to reduce the impact of the 

traumatic scene. However, 3D models of the bone evidence can also serve as a proxy and 

valuable tool to visualize and present trauma in court. The paper discusses various 3D modeling 

techniques (Magnetic resonance imaging or MRI, CT and surface scanning) and their advantages 

and applications in a forensic context by providing examples of studies where 3D techniques 

have been successfully applied (e.g. Wozniak et.al. 2012; Buck et.al. 2013). However, the paper 

does not go in details in the creation and evaluation of 3D models of bone evidence.  
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Villa et.al. (2013) applied the Suchey-Brooks and Buckberry-Chamberlain methods on 3D 

models created through CT and laser scanning. The two conventional osteological methods are 

used to assess age based on the analysis and scoring of the bone features of the pubic symphysis 

and auricular surface. The study examines how these features can be evaluated on 3D 

visualizations and whether the different modalities (direct observations of bones, 3D models 

from CT and laser scanning) are alike to different observers. Seven observers thus applied the 

age estimation methods on 3D models and on the actual bones. The models from CT scanning 

and laser scanning were compared first to the actual bones and then to each other. The best inter-

observer agreement for bones versus 3D models, with highest values was for auricular surface. 

Between 3D modalities, less variability was obtained for the 3D models from laser scanning. The 

study showed that the conventional methods perform best on dry bones, although they can be 

successfully applied on 3D models, albeit with reduced accuracy (Villa et.al. 2013).  The study 

does evaluate the 3D models relative to the physical bones and goes into some detail about 

explaining the evaluation process. However, the focus of the study was not specifically to 

examine the identifiability of the bone features but rather to examine the reliability of Suchey-

Brooks and Buckberry-Chamberlain methods on 3D models, a purely quantitative method.  

The focus of this thesis differs from previous studies as it mainly focusses on the comparison of 

the models with the actual bones rather than primarily comparing methods to each other or 

applying conventional osteological methods on 3D models. Furthermore, the evaluation process 

and its criteria are detailed, and the relative identifiability of the chosen morphological traits that 

serves as the standard of evaluation is qualified and made comparable using my own scoring 

system (presented in chapter 2). Thus, while the evaluation will be primarily qualitative, the 

scoring system makes my results potentially relatable to other studies, unlike a regrettable 

portion of previous studies. 

1.4 Theoretical Framework 

1.4.1 Osteological Identifiability 
There is a crucial difference between reading bones and reading models of bones. The former 

can be classified as “remains” – objects without agency that we can use to tell things about the 

past, and that hence cannot outright lie to their “reader”, although they certainly can be 

misinterpreted. Digital models on the other hand are digital representations of objects that 
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represent the state of the object at the specific time of acquisition and often for specific purposes. 

Unlike remains, the digital models are not fixed objects and are thus open to exploration and 

transformation (Younan 2015, p. 241; Jeffrey 2015). In some senses, models are more analogous 

to sources than to remains. A model is made from an original, and purports to depict it, but it is 

not simply an objective “digitization” – that is, a simple transfer of content from one medium to 

another. Neither software nor digitizers are objective: much like sources, they have the purpose 

to represent their subject matter. The model is the result of the digitizer’s choices and skills, as 

well as the methods and tools used. Osteological analysis of models requires the osteologist to 

take into account not only additional taphonomic traits acquired in the process of digitization 

(metaphorically speaking) such as blurriness of textures and smoothening of geometry, but also a 

number of source-critical problems that one usually does not have to grapple with in osteology. 

To determine how much influence, the digitizer’s choices can have on the model’s capacity to 

represent its original, and hence how large these source critical issues are, is a difficult problem 

that I will return to touch on in due course. 

The osteologist that analyzes a digital model does not want to interpret the model itself. Rather, 

he or she wants to decode what this model conveys about an original, so that the original can be 

interpreted through the model. But as we have established, a digital model is not simply a 

symmetrical direct translation of the original contents into a new medium. From the choices and 

efforts required on part of the digitizer to represent the original, it follows that the digitizer and 

the interpreter play two counterparts in an act of communication. The role of the digitizer is to 

encode; the role of the interpreter is to decode. In the course of the following chapters we will be 

able to explore some methodological problems and solutions this entails in encoding and 

decoding respectively. 

From these points follows that if 3D representations of osteological traits are to be used in 

osteological studies, they need to be more than accurate, they need to be identifiable. This is 

because osteology is hermeneutical: when the osteologist reads the bones, he or she identifies 

specific signs with specific meanings (or a range thereof). While I take the word “accuracy” to 

signify the technical accuracy (closeness between measured and known quantities) of the 

digitized trait while “Identifiability” in this case refers to the ability of osteological signs (i.e. 

traits bearing meaning in the science of osteology) to be identified and interpreted on 3D models. 
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While complete accuracy is of course a theoretical impossibility, even a digitized trait that may 

be deemed significantly inaccurate by an evaluator due to e.g. distorted shapes, blurriness and/or 

smoothened geometry may be sufficiently identifiable to be correctly interpreted by an 

osteologist in digital osteological analysis. 

1.4.2 Outsourcing Digitization – a Scientific Problem 
In light of these factors, we can begin to discern some compelling reasons for osteologists to 

involve themselves in digitization rather than to leave it entirely up to technicians without 

osteological background. Ability to ensure accuracy does not necessarily entail the capacity to 

discern identifiability. White et.al. (2012, p. 341) cautions that “color, texture, internal anatomy, 

matrix cover, consolidant cover, preparation damage, erosions, and distortions of all kinds may 

be faithfully recorded by such imaging of the original, but for the osteologist looking at a 

computer monitor on the other side of the planet, these features may not be digitally 

distinguishable from the actual bony anatomy.” Expertize in the digitization process ought to 

considerably alleviate such concerns. Also from the perspective of the theory of science, it is 

problematic to outsource digitization. As scientists, we attempt to produce knowledge that is 

“scientific” in quality. Plato famously defined epistêmê (scientific knowledge) as “justified true 

belief” (Ichikawa & Steup 2012). This means that knowledge not only needs to be objectively 

true to be scientific, the scientist also needs to understand the basis for his belief and ascertain 

that these are valid reasons. While the first of Plato’s criteria might be up for debate in this day 

and age, the second is quite universally acknowledged as a constitutive element of science. From 

this, it may be concluded that understanding the science every step of the way is crucial to 

producing scientific knowledge. Furthermore, using digital models as empirical material without 

participating in the process is problematic from the perspective of empiricism. If an osteologist 

makes an interpretation based on a model whose relationship to its original he or she cannot fully 

account for, there is good reason to question whether this interpretation be said to be either 

epistemic or empirical. Not only does outsourcing make it difficult to identify and resolve 

technical errors and methodological problems, one must also relinquish all control and 

understanding of the various choices and interpretations that are inevitably implicit in all 

digitization processes. If we are to achieve the full potential of this promising new technology, it 

must be integrated into osteological theory and method. This is not to discourage collaborations 
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between osteologists and experts with technical background but rather to encourage genuine 

collaboration and to caution against excessive division of labor. 

2. MATERIAL AND METHODOLOGIES 

2.1.1 The traits and the conventional osteological methodology 
My case studies consist of two human skeletal remains – a cranium and a metatarsal bone. The 

cranium represents a complex specimen while the metatarsal bone is comparatively simple in the 

sense that the former has more complex shapes as well as more morphological traits of 

osteological significance. Not only do crania have more complex shapes than metatarsal bones in 

general, but in this particular case the fragmentation of the bone which make up the inferior part 

of the cranium adds additional complexity. Due to this fragmentation, the cranium is bowl-

shaped, something that allows access to some parts of the endocranial or internal surfaces of the 

specimen. One reason why the two bones were chosen was to examine whether a more complex 

bone – the cranium – would be more challenging to digitize than a less complex bone –  the 

metatarsal bone.  

Another factor informing the selection of the material is their diversity of morphological traits 

that can provide a broad range of vital information about the individuals they belonged to in 

terms of age, sex, ancestry, state of health as well as the taphonomic process which influenced 

their skeletal remains. Of course, to make a reliable assessment pf these variables, would require 

analysis of several osteological traits, such as in the case of sex, the primary traits on the hip 

bone especially (Buikstra & Ubelaker 1994, p.16-21; Steckel et.al. 2011, p. 9-11, 19-25). Again, 

the purpose of the case studies is not such estimations per se but instead to contrast the traits on 

the physical bones vis-á-vis the 3D models in order to evaluate the capability of the latter to 

represent their physical originals. While this study’s stated purpose is to present an overall 

evaluation of the digital models, available space dictates that its scope must be delimited to 

number of morphological traits of osteological significance. Six morphological traits – four of 

the cranium and two of the metatarsal bone will be thus be evaluated on the 3D models of the 

bones.  
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2.1.2 Cranium 

Four morphological traits of the cranium are of especial interest, namely (a) changes associated 

with cribra orbitalia (b) the coronal and lambdoid sutures, (c) the breadth of nasal cavity, and (d) 

the length/size of mastoid process. Under normal circumstances through osteological analysis, 

these traits can be analyzed to provide information on the individual is state of health, age, 

ancestry and sex. 

Trait 1: Changes associated with cribra orbitalia 

Cribra orbitalia (a) is a pathological change often linked to iron deficiency and anemia (acquired 

or inherited), caused by blood loss or deficiency in red blood cells or hemoglobin. However, 

recent studies also link these changes to vitamin deficiencies (e.g. vitamin B12), malnutrition and 

infectious diseases (e.g. parasitic infections). Cribra orbitalia has been documented on skeletons 

from various time periods in a range of locations and is often used as one of the indicators which 

can be analyzed to assess the overall state of health in populations (Galea 2015; Naveed et.al. 

2012; Walker 2009, p.109-111). Sieve-like porosities (fig.1) on the upper surfaces of the orbital 

roofs of the cranium were documented. These features characterize cribra orbitalia and thus the 

initial diagnosis was precisely that. The intact orbital surfaces without sign of external damage or 

modification indicate that the porosities could not have occurred post-mortem. Furthermore, 

capillary-like impressions (fig.1) were also documented on the orbital roofs, interactive of 

healing (Steckel et.al. 2011; Stuart-Macadam 1985). 

Figure 1. Bilateral cribra orbitalia affecting both orbits of the specimen that was digitized. 
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Trait 2: The coronal and lambdoid sutures 

Cranial sutures are one of the traits that could be analyzed to estimate age at death. Generally, 

sutures close or fuse with increasing age, although there is a considerable variability in closure 

rates. Information of suture closure is useful when used in conjunction with other attributes. In 

this case only the ectocranial sutures (b) will be evaluated due to time constraints. The 

ectocranial sutures consist of the coronal, sagittal and lambdoid sutures. In terms of stage of the 

closure, the sagittal suture is completely fused, while the coronal and lambdoid suture (fig.2) 

could in some areas be considered to be of minimal and in some areas significant closure (Falys 

& Lewis 2010; Buikstra & Ubelaker 1994, p.32-35; Meindl & Lovejoy 1985). 

 

Figure 2. The ectocranial sutures comprised of fused sagittal suture (right image), coronal (upper 

image), and lambdoid (lower image) sutures.  

 

Trait 3: Nasal breath 

The height and breadth of the nasal cavity is usually measured in forensic contexts to assess 

racial affiliation and in anthropological contexts in repatriation work to preserve data from 

inaccessible skeletal materials but also to assess ancestry, and hominin development and 

adaptation. The nasal height is the distance from nasion (the point of intersection between the 

frontal-nasal suture and the midsagittal plane) to the midpoint of a line connecting the lowest 
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point of the inferior marging of the nasal notches while the nasal breath is the maximum breadth 

of the nasal aperture. Since this thesis’ purpose is not to assess race or ancestry but rather only to 

evaluate the identifiability of the models, and since time is limited, nasal height will be foregone 

and only the identifiability of nasal breadth will be evaluated. The nasal breadth (fig.3) was 

measured by first finding the widest part of the nasal cavity and using a digital sliding caliper 

measure its distance from edge to edge by sliding the caliper´s outer jaws. The distance was 

measured three times as measurements can differ each time. The process resulted in three 

measurements – 23. 37, 23.43 and 23.37 mm thus the nasal breadth was estimated to be 

approximately 23 mm (Márquez et.al. 2014; Cox et.al. 2014, p.326-327; White et.al. 2012, p. 54-

58, 339; Lindberg 2003; Buikstra & Ubelaker 1994, p. 69-75).  

  

  

  

  

 

 

 

  

 

Figure 3. The nasal breadth measured. Image by Helene Wilhelmson. 

 

Trait 4: Mastoid process length 

The mastoid process (fig.3) can be visually analyzed and its length measured (i.e. from the upper 

border of the external auditory meatus to the tip of the mastoid process) to estimate sex. The 

mastoid region is favorable for sex determination for two reasons: (i) the compact structure of 

the petrous portion making it resistant to physical damage and (ii) its protected position at the 

base of the skull. From the size of mastoid bone, sex can be estimated, a larger mastoid 
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suggesting male sex and a smaller mastoid suggesting female sex. Estimating sex based on 

cranial features can be challenging as there is significant variation between populations and 

between sexes (Passey et.al. 2015; Shah & Patel 2013). In this case the length of the mastoid 

process is of interest to examine the accuracy of the 3D models of the cranium in terms of scale 

and the measurements which could be obtained from them. The mastoid process is a bit 

fragmented, something that didn´t pose any problems during the measurement. The distance 

from the upper border of the external auditory meatus to the tip of the mastoid process was also 

measured with a digital sliding caliper three times sliding the calipers outer jaws above the bone 

resulting in measurements ranging from 34-37 mm (White et.al. 2012, p.54-58. 339; Steckel 

et.al. 2011, p.9-11; Lindberg 2003; Buikstra & Ubelaker 1994, p.20-21). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 4. The length/size of mastoid bone measured. Image by Helene Wilhelmson.  

 

 

2.1.3 Metatarsal Bone 
 

Trait 5-6: Callus formation and root impressions  

Healed fractures are characterized by a callus formation or bone growth (fig.5) formed during the 

healing process. It often gives the affected area a more rounded and protruding shape. The 

metatarsal bone displays these features thus diagnosed as healed fracture. Bone fractures indicate 
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trauma (accidental or intentional) which can occur for numerous reasons, most often as a result 

of sufficient strong forces of tension, compression, torsion, bending, or shear applied to a bone. 

As its fracture is healed the traumatic incident must have occurred antemortem (before death) as 

callus formation would be absent if it occurred perimortem (around or short after death) or 

postmortem (sometime after death) (White et.al. 2012, p.433-435; Ortner 2003, p. 126-127).  

 

Root impressions (fig.5) were also documented on the metatarsal bone caused by root etching. It 

is one of the taphonomic agents and processes that can influenced the morphology and 

preservation of bones. These can in turn influence the osteological analysis and thus 

interpretation of bones as poorly preserved bones can make analysis difficult or in some cases 

impossible. Furthermore, it is vital for osteologists to be able to differentiate between various 

traits whether caused by taphonomic processes, trauma or pathological conditions in order to 

avoid misinterpretation (Brickley & McKinley 2004, p.15-16).   

 

 

 

 

 

 

 

 

 

 

Figure 5. The metatarsal bone with close up image of its diaphysis 

depicting the root impressions (close-up image).  
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2.2 Digital Methodologies 
Each specimen was photographed using a Canon EOS 550D digital camera mounted on a tripod 

(Canon 2016). The photo acquisition was performed in a well-lit room. Prior to photo 

acquisition, the object was placed inside a photo tent which was lit by two standing lights. Inside 

the object was placed on a turntable that comes with the NextEngine 3D laser scanner Ultra HD 

which will be discussed below. This turntable was in turn placed a wooden turntable to raise the 

object in the sight of the camera, and enable rotation and thus capturing of the object 

systematically. For detailed description of the photo acquisition, camera settings, and equipment 

information, see appendix 2. 

3D models of each specimen were created through three surface modeling techniques –scan-

based modeling (SBM) using the Nextengine laser scanner and MeshLab1.3.4BETA (latest 

version), image-based modeling (IBM) using a digital camera and Agisoft PhotoScan software 

(standard edition) and combined modeling (CM) by combining SB and IB models into one 

combined model using both MeshLab and Agisoft PhotoScan software. A brief workflow over 

the process of each modeling procedure with information of the equipment used is available 

below. For a more detailed workflow, see appendix 1-3.   

2.2.1 Scan-based (SB) modeling 
Scan-based modeling (SBM) is performed with optical systems that measure and thus capture 

surface data of an object through identifiable light (i.e. non-ionizing radiation) using 3D scanners 

such as  a NextEngine 3D scanner Ultra HD, a low end close-range laser scanner which operates 

according to the triangulation principle, where the position of the emitter (i.e. the scanner that 

emits light towards the object), the detector (i.e. the cameras of the scanner that capture the 

light´s reflection) and the object are defined by known angles and distances vis-à-vis each other, 

together forming a triangle shape (Friess 2012). The scanner connects to a laptop computer, in 

this case a Lenovo 540 laptop with 64 gigabytes (GB) of random access memory (RAM), a 

powerful computer fit for processing heavy data and demanding processing. 

The NextEngine 3D scanner comes equipped with a turntable which enables it to rotate during 

scanning. Each bone was placed on this turntable, and in the case of the cranium, a donut-shaped 

Styrofoam was used to fix it in position. A part-gripper that comes with the turntable platform 

was used to hold the metatarsal bone – that unlike the cranium cannot not stand on its own – in 
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place during scanning. The scanning process goes as described: first, the scanner collects surface 

data of the object, which is similar to taking a photograph. Next, four laser beams slowly move 

across the surface of the object, capturing data points that make up the polygons, which in turn 

form the geometric structure or surface of the object. Once a single scan is complete, the 

turntable rotates to capture the object in a different angle and the process begins anew until the 

desired number of scans is achieved (Means et.al. 2013; Kuzminsky & Gardiner 2012, p. 274). 

ScanStudio HD Pro software, a scan data processing software that comes with the scanner, was 

used to process (clean and align) the scans into a rough SB model (NextEngine 2016; Payne 

2009). MeshLab, an open-source mesh processing tool, was in turn used to further process the 

rough SB model through cleaning filters and poisson filter which filled to obtain a water-tight SB 

model (MeshLab 2014; Cignoni et.al. 2008; Friess 2012, p. 5-6). A brief workflow of the process 

is presented below. For a more detailed workflow with parameters, see appendix 1. 

2.2.2 Image-based (IB) modeling 
Image-based modeling (IBM) also operates according to the triangulation principle as the 

method is based on photography with the camera being the emitter which sends out light towards 

the object to capture it in different angles during photo acquisition. The light bounds back 

towards the camera which captures it and thus obtains information of the surface of the object 

that it converts into an image (Barnes 2009; Chi 2016). The same equipment, room setting and 

camera settings were used to obtain overlapping images of each specimen. Agisoft PhotoScan, a 

standalone software that performs photogrammetric processing of digital images was used to 

process the acquired images into an IB model of each bone (Agisoft 2016). In the software the 

background of each image was masked out, and the images aligned to generate first a sparse 

point cloud (cluster of points from the images) and later a dense cloud (denser cluster of points) 

that was processed into a IB mesh or model where a texture (color information from images) 

could be applied to obtain a complete IB model. A brief workflow of the process is presented 

below. For a more detailed workflow with parameters, see appendix 2.  

2.2.3 Combination (CM) models 
Combined-based model (CM) where the SB and IB models of each specimen were aligned and 

processed using MeshLab and Agisoft PhotoScan were created for each specimen. In the former 

software, the SB and IB models were aligned. In the latter, texture was applied to the acquired 
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CM model which was imported back into MeshLab where it was aligned once more to obtain the 

final CM model with combined properties from both model types – the accurate and high quality 

geometry of the SB model with the high quality textures of the IB model. Hence, it would be 

interesting to see how the identifiability of the traits and the accuracy of the models would differ 

in terms of scale on a 3D model with combined properties. A brief workflow is presented below. 

For a more detailed workflow, see appendix 3. 

2.2.3 Surface modeling workflow 
Scan-Based Modeling 

Since the cranium and metatarsal bone differ in size and shape, different scanning parameters 

were used in order to create the highest quality model possible of each specimen. The scanning 

positions and the number of times each remain was scanned also differed. For more detailed 

workflow and the parameters used, see Appendix 1. For a more detailed in-depth description of 

the workflow, the parameters and the scanning positions, see appendix 2.  

Each specimen was scanned in 360 degrees using the NextEngine 3D laser scanner, three times 

in the case of the cranium and two times in case of metatarsal bone, each time in a different 

position. The scans obtained were imported in ScanStudio software where each scan was 

trimmed (cleaned), removing unnecessary parts such as parts of the donut-shaped styrofoam that 

was digitized along with the cranium (fig.6). Subsequently, the individual scans were aligned 

into a rough SB model (fig.6). The SB model was later imported in MeshLab where it was 

cleaned using three cleaning filters to remove remaining noises and unnecessary parts from the 

model. Finally, the poisson filter was applied which filled the holes located in areas that had been 

inaccessible to the scanner (e.g. the inner parts of the cranium). The rough edges and surfaces of 

the model was smoothened by the filter and the model was decimated (the number of polygons 

reduced) while preserving the original geometry of the model as much as possible. However, this 

process makes the model lose its texture. The SB models of the cranium and metatarsal bone 

thus come to lack texture. A flowchart of the whole process is presented below (fig.7).  
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Figure 6. One of the scans of the cranium being trimmed (left image) and the scans (right image) 

being aligned into a rough SB model. 

 

 

 

 

 

 

 

 

Image-based modeling 

Each specimen was photographed in different positions and from different distances to capture 

all surface bone and the morphological traits of interest. The overlapping images, 280 in the case 

of the cranium and 147 in the case of the metatarsal bone, were imported in Agisoft PhotoScan. 

First each image was inspected and the blurred ones were culled from the pool. Then, the 

background of each image was masked out to shorten the aligning process. 

Scanning object
Trimming

scans

Alignning

scans

Applying

filters 
SB model

Figure 7. Flowchart of the scan-based modeling process.
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The images were later aligned in “high accuracy”, an accuracy parameter which helps to obtain a 

more accurate estimate of camera position, the position in which each image were taken (fig.8). 

The alignment resulted in a sparse point cloud, a sparse clustering of vertices which make up the 

outer surfaces of the model. Unnecessary points (e.g. far away and unrelated points) were 

deleted; first manually by using the selecting and deleting tools in edit menu, then by the tool 

Gradual selection that removed missed erroneous points (e.g. unreferenced and duplicated). The 

sparse cloud was turned into a dense cloud, a denser clustering of raw points which makes up the 

outer surfaces of the model. The dense point cloud was built, setting the reconstruction quality 

parameter to “high quality”, for more detailed and accurate geometry. Again, unnecessary parts 

were trimmed manually from the dense cloud. The dense cloud was in turn processed into a 

model setting the face count parameter, the parameter for desired model quality, to “high”. 

Finally, a texture of “high quality” was built and applied to the IB model (fig.9). Below is a 

flowchart of the process (fig.10). 

Figure 8. The camera position of the cranium (left image) and of the metatarsal bone (right 

image) visualized in Agisoft PhotoScan. 
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Figure 9. Texture applied on the image-based model of the metatarsal bone in Agisoft 

PhotoScan.  

 

 

 

 

 

 

 

 

Figure 10. Flowchart of the image-based modeling process. 

The IB models of the cranium and the metatarsal bone were scaled one by one to real measure 

method in MeshLab (Dellepiane 2013; Visual Computing Lab: Matteo Dellepiane 2016). The 3D 

models generated through laser scanning using the Nextengine scanner have, according to 

previous studies and the manufacturer, automatically accurate scale since the scanner have the 

ability to capture not only the surface of the object, but also its scale (Sulaiman et.al. 2012; 

Nextengine 2016). First a reference measurement was taken from the real bone, which in case of 

the cranium was the breadth of the right orbit and in case of the metatarsal its length. The 

cranium was placed on a table in frontal position and the breadth of the orbit from edge to edge 
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Masking Spare point cloud
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was measured three times sliding the outer jaws of the same digital caliper using a digital sliding 

caliper. The length of the metatarsal bone was similarly measured three times also from the front 

view, sliding the outer jaws of the caliper on the top edge to the bottom edge of the bone. Later, 

each model was imported into separate projects in Meshlab process separately. The model of 

each bone underwent the same procedure. The same features were measured on each model (also 

three times) using the measuring tool available in MeshLab. The scaling factor was later 

calculated by dividing the measurement from the bone, divided with the measurement from the 

3D model. In the case of the cranium, the real measurement (based on three measurements) was 

roughly 44 mm and the measurement from the 3D model was roughly 2 mm and the calculation 

was 44/1,5= 28,6 or roughly 29 mm. In the case of the metatarsal, the real measurement was 

roughly 69 mm and the model measurement 3 mm thus 69/3 = 23 mm. The value obtained was 

later used to scale each model using the filter> Normal, Curvatures and Orientation> Transform: 

Scale (fig.11). In the filter window the value was entered in the “x-axis” field and the boxes 

“Uniform Scaling” and “Freeze Matrix” were checked for permanent scaling (fig.11). To apply 

the filter, the “apply” button was pressed and after a few seconds the model being processed was 

scaled (Dellepiane 2013; Visual Computing Lab: Matteo Dellepiane 2016). To verify that the 

procedure had succeeded, the same features were measured on the models again and the result 

compared with the actual measurements. 

 

 

 

 

 

 

 

 

 

Figure 11. The IB model of the metatarsal bone being scaled in MeshLab.  



38 

 

Combination modeling 

A combined-based model (CM) of each bone was created in separate projects using the 

procedure described below. The SB and IB models were imported into MeshLab where they 

were manually aligned using the IB model as main while the SB model was virtually glued or 

positioned to the SB model. The alignment was conducted through the distribution of points 

though enabling the parameter allow scaling prior to the distribution. A total of eight points were 

used, placed one by one on the exact corresponding location on both the SB models and IB 

models (fig.12).  

 

 

Figure 12. the alignment of the SB and IB models in MeshLab through point distribution. 

 

After the alignment of the SB model, it was duplicated and the copy was frozen in position. The 

process gave the SB model’s copy the inaccurate scale obtained from the IB model. However, 

this enabled the SB model copy to be imported into Agisoft PhotoScan in the same project where 

the IB model was created. Once the SB model copy was imported into the project the IB model 
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in the project disappeared as the software only allows one model at the time. A high quality 

texture (5000 x 2) was generated and applied on the SB model copy in Agisoft PhotoScan. The 

textured SB model copy was then imported back in MeshLab in the same project where the 

alignment of the models was conducted. There, the SB model copy was automatically aligned 

with the other models setting the original SB model with the accurate scale as the main. 

However, this is only some automatically if there are at least three models to be aligned, an 

automatic setting of the aligning procedure in MeshLab. After the alignment, the SB model copy 

was frozen in position and was saved. A flowchart over the process is available on the next page 

(fig.13). 

 

 

 

 

 

 

 

 

Figure 13. Flowchart of the combination modeling process. 

 

2.2.4. Morphological analysis and evaluation 
The models were analyzed in the MeshLab interface. First, the overall quality of each model was 

visually analyzed by rotating the model, documenting errors such as holes in the geometry which 

weren’t present on the surface of the bone, blurriness and discoloration of texture of the model 

and unevenness of some areas of the geometry due to the hole filling process of the poisson 

filter. The metadata of each model was also noted – i.e. the number of vertices and faces. 

The identifiability of six morphological traits on the cranium and the metatarsal bone – the 

changes associated with cribra orbitalia, the ectocranial sutures, the length of mastoid process, 
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the nasal breadth on the cranium, the callus formation and root impressions– were analyzed on 

the SB, IB and CM models of the cranium and the metatarsal bone. The identifiability of the 

surface traits: the first two traits of the cranium and last two traits of the metatarsal bone were 

evaluated qualitatively where each trait was visually analyzed and their identifiability graded 

both on geometry and textures. The identifiability of each trait was graded in accordance with a 

grading system I have devised: 

0 = absence of features  

1= low identifiability, blurry, and major loss and/or distortion of traits 

2 = identifiable, blurry, but some loss and/or distortion of traits 

3 = high identifiability with little/no loss and/or distortion of traits 

However, the identifiability of the callus formation was based on its rounded and protruding 

shape, and thus the scoring system above would be inappropriate as it is created to score surface 

features. Hence, the identifiability of the callus formation will be scored either as high or low. 

On the geometry of each model, the traits were analyzed visually and scored one by one, at first 

without enhancing shaders (i.e. small programs which renders and visualize the geometry of the 

model through visual effects). Then, two shaders, namely two types of radiance scaling – 

Lambertian and Lit Sphere were applied due to their ability to enhance the identifiability of 

details (or in this case traits) on the geometry of 3D models. The models were visualized in 

MeshLab (e.g. Vergne et.al. 2010; Granier et.al. 2012). On the texture of each model, each trait 

was also visually analyzed and scored in MeshLab but also in Agisoft PhotoScan where the 

models could be visualized. The identifiability of each trait was documented using an open 

source snipping tool (for snapshot) and the snapshot tool function in MeshLab. 

The results from the analysis of the identifiability of the four morphological traits and the 

measurements of the nasal breadth and the length of mastoid process obtained were compared to 

the identifiability of the traits on and to the measurements taken from the cranium and the 

metatarsal bone. The result of the comparison revealed how well the 3D models can represent the 

traits and thus demonstrate the capability of the 3D methods to generate valuable models. 

Furthermore, the results of the analysis of each model were compared between models to 

determine which model and thus method could represent the morphological traits most and least. 

The flowchart (fig.14) show the evaluation process. 
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2.2.5 Model comparison 

An overall digital comparison of the SB, IB and CM models were also conducted using Cloud 

Compare software, an open-source 3D point cloud (and triangular mesh) processing software to 

assess surface deviation (difference in geometry) between the models (Girardeau-Montaut 2016). 

The procedure was the same for each session and is described in the workflow below. 

The models of the cranium were compared with each other and the models of the metatarsal bone 

with each other. The SB and the IB models were compared, then the SB and the CM models and 

finally the IB and CM models. The models were imported (File> Open) one by one in Cloud 

Compare software. A rough registration of the models was conducted by selecting both models 

(one by one) and using the registration tool (Tools> Registration> Match bounding box centers 

method) to make their centers of gravity match in the 3D space. Then, one of the model was 

selected and moved (right mouse button to pan) as close as possible to the other model so that 

they roughly overlap. Furthermore, with the Interactive Transformation Tool (Edit> 

Translate/rotate) moved the model could be translated and rotated to overlap even more with the 

other model. A fine registration of the models was also conducted to make sure that they really 

overlapped. Subsequently, the models were finely registered by selecting the models one by one 

and applying the Fine Registration Tool (Tools> Registration> Fine registration). In the 

registration window the parameters (appropriate for models of small-medium objects) were set 

(fig. 15) before the application. Finally, the models were compared by selecting both (one by 

one) and choose the appropriate distance tool. In this case the tool used was Cloud-to-Mesh 

Distance (Tools>Distances> Cloud/Mesh Dist.) that compares the models based on the points 

that make up the models (fig.16). The procedure result in two values for mean distance and 

Documentation

• vertices, faces and 
texture size

Analysis

• model errors

• trait identifiability 
and  measurements

Comparison

• 3D models vs. bones

Figure 14. Flowchart over the evaluation process. 
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standard deviation as well as a 3D model in different colors which visualizes the degrees and 

area of deviation (fig.16).  

Figure 15. The IB and SB models being finely registered.  

 

 

 

 

 

 

 

Figure 16. The result of the model comparison with the model and color scalar depicting surface 

deviation with a snapshot of the parameters used.  
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3. RESULTS  

3.2 Model Identifiability  

3.1.1 Scan-Based Models 
Cranium 

The SB model of the cranium consists of approximately 4 million vertices and around 8 million 

faces. The point cloud is dense overall, but sparse in many internal parts (fig.17A), the reason 

being that much of the internal surfaces of the cranium could not be captured during scanning. 

This opening that exposes the endocranial surfaces facilitated scanning of most of these surfaces, 

but the complex shape made it difficult for the beams of the scanner to scan certain areas, thus 

resulting in holes in the model in those areas (fig.17B).  

Even so, the initial cranium model (around 19 million vertices and 38 million faces) was still too 

heavy, and thus it was processed into a more manageable model through the application of the 

poisson filter in MeshLab. The filter decimated, smoothened and filled the holes of the rough SB 

model, resulting in the watertight SB model presented here. This process did indeed create a 

more manageable model with reduced size and overall great surface quality, but it created new 

protruding and uneven surfaces that fills the holes (fig.17C). Another erroneous area is the raised 

area of the right orbital roof, presumably caused by the same process where there was a gap 

separating the bit of the upper part of the orbital from its lower part. Furthermore, the filter only 

affects the geometry of model, and thus the texture from the initial model was automatically 

excluded during the process. The SB model which was analyzed was thus without texture. Apart 

from the uneven areas of the internal parts due to the hole filling process of the poisson filter, the 

geometry of the model is quite great overall with accurate scale and many details of the actual 

cranium being preserved (fig.17D). 
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Figure 17. A: Point cloud sparse in the internal areas, B: holes in the internal parts, C: protruding 

and uneven internal surfaces (marked red) and, D: the model in right view.  
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Metatarsal bone 

The initial model of the metatarsal bone was also heavy (c. 4 million vertices and 7. 6 million 

faces) and was thus processed through the application of the poisson filter into a water-tight 

model with 900 000 vertices and 1.7 million faces. The process also leads to loss of texture 

(18A). The model consists of a very dense point cloud, the points being identifiable only in a 

zoomed in state (fig.18B). The overall quality of the model is great without erroneous surfaces or 

holes in the geometry and with accurate scale. Furthermore, its geometry also appears detailed, 

indicating that many of the metatarsal bone´s features were captured during scanning (fig.18C). 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 18: A. The model lacking texture, B: dense point cloud in zoomed in state and, C: the 

model in the right view.
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3.1.2 Image-Based Models 
Cranium 

The model consists of approximately 2 million vertices and 4 million faces. The point cloud of 

the model is quite dense overall, but sparse in the innermost parts which couldn´t be captured 

during photo acquisition, thus resulting in holes in those areas (fig.19A). Holes were also 

documented in the lower surfaces of the right orbital. Its geometry appears to be of lower quality 

overall, with blurriness and less details on its geometry compared to the geometry of the SB 

model of the cranium (fig.19.B). However, it has a texture (5000x2) which is of excellent 

quality, making it appear more realistic and detailed (fig.19C).   

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 19. A: the sparse area of the point cloud, B: the geometry of the model in right view and, 

C: the model with texture in right view. 
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Metatarsal bone 

The model consist of roughly 90 000 vertices and 180 000 faces with sparse point cloud 

(fig.20A-B). No errors in terms of holes have been documented on the geometry, although the 

geometry appears less detailed and blurry compared to the geometry of the SB model. However, 

as in the previous case, the IB model has a texture (5000x2) which is also of excellent quality, 

giving the model a realistic appearance (fig.20C). 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 20. A: Sparse point cloud. B: the geometry of the metatarsal model. C: the texture of the 

model.
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3.1.3 Combination models 
Cranium 

The combined model consists of 4 million vertices and 8 million faces. The point cloud of the 

model is dense, but some of its internal parts are quite sparse (fig.21A) as its geometry is based 

on the geometry of the SB model of the cranium. The uneven areas in the internal parts from the 

SB model are thus present on the geometry of the CM model. Another inherited error is the 

raised and uneven area of the orbits (fig.21B). However, aside from these errors, and as with the 

SB model, the geometry of the CM model is of great quality with great detail and accurate scale 

errors below (fig.21). Unlike the SB model, it has a texture of great quality inherited from the IB 

model (fig. 21C). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 21. A: the uneven internal surface marked red 

and, B: the raised area of the right upper orbital. C: 

the model with high quality and realistic texture. 
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Metatarsal 

The CM model of the metatarsal bone is comprised of approximately 900 000 vertices and 1, 7 

million faces. Its geometry is also based the SB model of the bone which is of great quality with 

its detailed surface and accurate scale (fig 22A). Its texture is also of excellent quality – detailed 

and realistic (fig.22B).  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 22. A: the geometry of the model and B: the model with a realistic texture. 
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3.1.4 Results of model comparison 
 There standard surface deviation between the IB and the SB model of the cranium was 0,00217 

mm while the standard deviation between the SB and CM model was 0.00129. Finally, the 

standard deviation between the IB and CM model was 0.001526. In the case of the models of the 

metatarsal bone. The standard deviation between the IB and SB model was 0.000527, between 

the SB and the CM model 0.001305, and finally between the IB and CM model 0.000568. The 

mean and standard deviation values are presented in a table below. Overall there is minimal 

surface deviation between the models which is even less than 1 mm (table.3). Hence, the model 

visualizing the surface deviation between models was more or less of the same color with some 

tiny color variation in areas where errors on the models have been documented (fig. 23). 

 

 

 

 

 

Table 1. Table over the Mean and Standard deviation between models. 

 

 

Model comparison  Mean distance (mm) Standard deviation (mm) 

Cranium: IB vs. SB 0.004978 0.000381 

Cranium: SB vs. CM 0.004511 0.001740 

Cranium: IB vs. CM 0.004979 0.000376 

Metatarsal: IB vs. SB 0.004895 0.000826 

Metatarsal: SB vs. CM 0.002592 0.003044 

Metatarsal: IB vs. CM 0.004833 0.001034 

Figure 23. The result of the SB and IB 

model comparison. 
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3.2 Trait identifiability and measurements 

3.2.1 Geometry 
Cribra orbitalia  

The surface of the right orbital roof is more affected by the changes associated with cribra 

orbitalia than the surface of the left orbital roof (fig.24A). On the right orbital surface, the 

identifiability of the changes was graded 1 due to its low identifiability, with major loss (i.e. 

capillary impressions) and distortion (raised surface of the upper orbital) of traits. The 

identifiability of the changes on the left orbital surface was also graded 1 despite that many of 

the porosities are present due to the fact that they are filled because of the application of the 

poisson filter which caused the unevenness of the area (fig.24B). With the application of the 

Lambertian (fig.24C) and Lit Sphere Radiance Scaling, (fig.24D) the identifiability of the 

existing changes increased. However, despite such measures, the grade of the changes on the 

orbital surfaces remain the same. Overall, the identifiability of the changes is low with major loss 

and distortion. None of the capillary-like impressions are present and the remaining porosities 

are distorted, filled and their surfaces have become uneven due to the application of the poisson 

filter. 

 

B 

A 
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Figure 24. A: the identifiability of the changes on orbital surfaces of the actual cranium, B: on 

the geometry without enhancements, C: with Lambertian shader and, D: with Lit Sphere shader. 

 

On the right orbital surface of the IB model, the changes are completely absent and they are thus 

graded 0. On the left orbital surface on the other hand, a few barely identifiable traces of the 

porosities are identifiable, thus being graded 1 (fig.25 A). With the application of shaders, the 

remaining porosities on the left orbital could be slightly highlighted. However, this was not 

enough to raise the identifiability above grade 1 (fig. 25B-C). 
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Figure 25. A: the changes on the geometry of IB model without enhancement. B: the 

identifiability with Lambertian shader. C: with Lit Sphere shader. 

 

On the right orbital surface of the CM model, the identifiability of the changes was graded 1 due 

to major loss and distortion of traits with only a few filled porosities remaining, raised surface 

also being documented on the SB model. On the left orbital surface, their identifiability was also 

graded 1, with the only porosities present being filled, causing unevenness of the area (fig.26A). 

With shaders applied, the identifiability of the remaining porosities was somewhat enhanced, 

especially with the Lit Sphere shader combination (fig.26B-C). However, their grading remained 

the same. 
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Figure 26. A: the changes on the model´s geometry without enhancement. B: on the geometry 

with Lambertian shader. C: on the geometry with Lit Sphere shader. 

 

The coronal and lambdoid sutures 

The identifiability of the coronal suture (fig.27A) was blurry and thus graded 1 (fig.27B). 

However, with the application of the shaders, its identifiability increased markedly, especially 

with the application of the Lit Sphere Radiance Scaling. With the Lambertian shader on, its 

identifiability was graded 2 (fig.27C) and with Lit Sphere it was graded 3, meaning that the 

suture in its entirety was as identifiable as it is on the actual cranium (fig.27D).  

The lambdoid suture was even more blurry and its identifiability on the geometry of the model 

without shaders was thus graded 1 (fig.28A). As expected, its identifiability increased with the 

application of the shaders. With the Lambertian shader (fig.28B), its identifiability was graded 2 

and with the Lit Sphere shader (fig.28C) its identifiability was graded 3. 
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Figure 27. A: The coronal suture. B: its identifiability on the geometry without shaders. C: With 

Lambertian shader and D: with Lit Sphere shader.   
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Figure 28. A:  The lambdoid suture. B: its identifiability on the geometry without enhancement. 

C: With Lambertian shader and, D: with Lit Sphere shader.    

C 

B 

A 

D 



57 

 

The identifiability of the coronal suture on the geometry of the IB model, was graded 1 with 

major loss of traits and blurriness (fig.29 A). With both shaders, the identifiability of the suture 

was increased very slightly, and was graded 1 (fig.29 B-C).  

 

 

Figure 29: A: The identifiability of the coronal suture on the IB model´s geometry without 

enhancing shaders. B: with the Lambertian shader and C: with the Lit Sphere shader. 
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The identifiability of the lambdoid suture was graded without enhancement on the other hand 

was more or less absent on the geometry with or without shaders thus graded 0 (fig.30 A-C). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 30: A-B: The lambdoid sutures with lambertian and Lit sphere shaders. C: Coronal suture 

discontinued as connecting suture have disappeared (box).   
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The nasal breadth of the cranium was measured to roughly 23 mm (fig.31A). On the SB model 

the nasal breadth ranges from 22 to 23 mm (fig.31 B). On the CM model it also ranges from 22-

23 mm (fig.31 C), while on the IB model it ranges from 23 to 24 mm (fig.31 D). The 

measurements taken from all models are presented below (table 4). 

 

 

 

 

 

 

 

 

 

Figure 31. A: The nasal breadth measured on the cranium. B: On SB model.  

C: On CM model. D: On the IB model. Table 2. The measurements of the nasal breadth taken 

from the cranium and the cranium models. 
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Mastoid process 

The length of the mastoid process which was roughly 34 mm was measured first on the cranium 

three times as the results can vary each time resulting in measurements (fig. 32 A). Then, the 

length of mastoid process was measured on the SB and CM models. In the case of the SB model, 

the length was roughly 34 mm (fig.32 B). On the CM model its length was also roughly 34 mm 

(fig.32 C). On the IB model the length of the mastoid process was roughly 32 mm (fig. 32 D). 

The measurements taken from all models are presented below (table 5). 

  

 

 

 

 

 

 

 

Figure 32. A: The length of the mastoid process measured on the cranium. B: on SB model.  

C: The on CM model. D: on the IB model. Table 3. The measurements of the length of mastoid 

process taken from the cranium and the models. 
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The callus formation and root impressions 

The identifiability of the callus formation was high on the geometry of the SB model (fig. 33 A). 

However, the identifiability of root impression was low on the geometry without enhancing 

shaders as was thus graded 1 (fig.33 B). With the application of the Lambertian shader, the 

identifiability of changes associated with root impression was increased and graded 2 (fig.33 C) 

and with the Lit Sphere they were graded 3 with high identifiability with little/no loss of traits 

(fig.33 D). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 33. A: The metatarsal bone with identifiable root impressions. B: The identifiability of 

root impression without enhancement. C: On the geometry with Lambertian shader. D: On the 

geometry with Lit Sphere shader.  
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As with previous models, the identifiability of the callus formation on the geometry of the IB 

model is high.  Without enhancing shaders the identifiability of the changes associated with root 

impression was low, and thus graded 1 (fig.34 A). With the Lambertian shader, the identifiability 

of the changes increased slightly, though remained graded 1 (fig.34 B). Despite application of 

the Lit Sphere shader the identifiability of the changes remained low and graded 1 due to major 

loss of features (fig.34 C). 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 34. A. Root impression on the geometry of the SB model without enhancement. B: With 

Lambertian shader. D: With Lit Sphere shader. 
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3.2.2 Texture  
Only the textures of the IB and the CM models were analyzed, since SB models with applied 

poisson filter lacks texture. Furthermore, only the identifiability of the changes associated with 

cribra orbitalia, the coronal and lambdoid sutures and the changes associated with root 

impression could be analyzed and graded since taking measurements from textures which are 

essentially 2D images would result in inaccurate measurements.  

Cribra orbitalia 

The identifiability of the changes associated with cribra orbitalia (fig.35 A) on the CM model 

was low due to its blurry and distorted state (fig.35 B). Furthermore, some of the errors (e.g. 

filled porosities) reviewed in the previous section on the geometry of the CM model are visible 

on the texture, and were thus graded 1. By comparison, the identifiability of the changes on the 

texture of the IB model was high. However, there is a significant difference in results when the 

texture was visualized and analyzed in Agisoft compared to when its analyzed in MeshLab. In 

Agisoft, their identifiability was graded 3 as all the changes are present and highly visible barring 

some blurriness on some areas (fig.35 C). In MeshLab their identifiability was graded 2 as it 

appears blurry with some loss of features (fig.35 D). The reason behind the difference in results 

is due to the fact that MeshLab automatically reduces the texture size of 3D models with high 

quality and multiple textures, and consequently this affected the identifiability of the features 

depicted on the textures (fig.35 E).  

A 

B 
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Figure 35. A: The changes on the actual cranium. B: On CM model in MeshLab. C: On the IB 

model in Agisoft. D: On the IB model in MeshLab. E: Snapshot of the layer dialog where texture 

size reduction (marked with red box) was specified. 
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The coronal and lambdoid sutures 

The identifiability of the coronal and lambdoid sutures (fig.36 A) on the texture of the IB model 

visualized in Agisoft was graded 3 despite some blurriness (f.36 B). Their identifiability on the 

same texture, although visualized in MeshLab was again lower as they appear blurrier and was 

thus graded 2 (fig.36 C). On the CM model, the changes are still quite identifiable and thus 

graded 2, although they are much blurrier compared to the IB model (fig.36 D).  
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Figure 36. A: The coronal suture on the actual cranium. B: On the IB model in MeshLab. C: 

On the IB model in Agisoft. D: On the CM model in MeshLab. 
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The identifiability of the lambdoid suture (fig.37 A) on the texture of the IB model in Agisoft 

PhotoScan was quite high, although the blurry areas reduced its identifiability to 2 (Fig.37 B). 

Visualized in MeshLab, the identifiability of the suture is even lower as it appears even blurrier, 

and was thus graded 1 (fig.37 C). The identifiability of the suture on the texture of the CM model 

also received the same grade (fig.37 D).  
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Figure 37. A: The lambdoid suture on the actual cranium. B: On the IB model in Agisoft. C: 

On the IB model in MeshLab. D: On the CM model in MeshLab. 
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The callus formation and root impressions 

The identifiability of both traits on the textured IB and CM models was high (fig.38 A). The 

texture does not affect the identifiability of the callus formation as it is still highly identifiable 

with or without texture on the geometry the models. The identifiability of root impressions are, 

however, affected by texture. On the texture of the IB model their identifiability was graded 3 

analyzed in Agisoft (fig.38 B). However, on the texture of both the CM model and on the IB 

model analyzed in MeshLab their identifiability was graded 2 as they appear darker and blurrier, 

thus lowering identifiability (fig.38 C-D).  

 

  

 

 

 

 

 

 

 

Figure 38. A: Changes associated with root impression on the actual metatarsal bone. B: On the 

IB model in Agisoft. D: On the IB model in MeshLab. C: On the CM model.  
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4.DISCUSSION 
The identifiability of the changes associated with cribra orbitalia was low on the geometry of the 

SB model with the loss of most traits and the distortion of the remainder. The capillary-like 

impressions were completely absent and some of the porosities were lost while those who 

remained were filled. On the geometry of the IB model, the identifiability of the changes was 

even lower, as they were more or less absent. Only a few porosities were present and could 

barely be highlighted through the application of shaders. There are some factors that led to this 

outcome. From a technical standpoint, the tiny porosities and the shallowness of the capillary 

impressions are problematic since the NextEngine 3D scanner has been shown in earlier studies 

to have difficulties digitizing fine and shallow details (e.g. Means et.al. 2013; Friess 2012). The 

traits’ location inside the concave orbital roofs compounds the problems, since NextEngine 3D 

scanner emits laser beams in one direction only, making digitalization difficult. Furthermore, the 

poisson filter applied on the scan-based models distorted the porosities on the models by 

automatically filling them and causing unevenness on the surfaces. However, on the IB model´s 

texture, their identifiability was high with all changes being represented. On the geometry of the 

CM model, their identifiability was low with the loss of most traits and the distortion of the 

remaining ones, as inherited from the SB model. More surprisingly, the identifiability of the 

changes on the texture of the CM model was also low, despite the fact that the texture of the CM 

model was generated from the IB model. In my view, this was mainly due to two factors: (i) the 

geometry on this particular surface was distorted and when the textures were applied, they were 

distorted themselves by the faulty underlying geometry, and (ii) the fact that the texture was 

visualized and analyzed in MeshLab, which automatically reduces the texture size, thus lowering 

the texture quality and resolution. In summary, with regards to cribra orbitalia, the third 

dimension was a liability. The trait could not be captured geometrically, and in the combined-

based model the geometry ended up distorting the textures, making the CM model less 

representative than the IB model. Conventional photography would better be able to substitute 

for the original than the 3D model in this case. 

Similar factors also impacted the identifiability of the coronal and lambdoid sutures and the 

changes associated with root impressions. On the geometry of the IB model, the sutures were not 

discernable at all. The coronal and lambdoid sutures were of low identifiability on the SB model, 

but their identifiability changed from low to high with the application of shaders to highlight the 
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sutures. On the geometry of the CM model, the identifiability of the sutures was initially low, 

although with the application of the enhancing shaders their identifiability become high. The 

shallowness of the sutures impacted their identifiability of the sutures on the geometry of the 

models, as the 3D modeling techniques, as already stated, has difficulties capturing fine details. 

Again, much like with cribra orbitalia, the poisson filter smoothened the sutures on some areas 

on the SB and CM models, thus causing additional blurriness. The sutures were, however, of 

high identifiability on the texture of the IB model, although on the CM model´s textures they 

appear blurry and their identifiability is low. The reasons for this seems to be the same as with 

cribra orbitalia. 

As for the changes associated with root impressions, their identifiability on the geometry of the 

SB and CM models of the metatarsal bone were initially low, but with the application of 

enhancing shaders, their identifiability increased markedly. Surprisingly, with shaders the 

identifiability of the traits was even higher on the geometry of the SB and CM models than on 

the actual bone. Removing the texture and applying enhancing shaders or lighting like this would 

not be possible with the actual bone, and this showcases one of the great advantages of 3D 

models and 3D modeling techniques, especially as compared to photo documentation. As 

expected, the changes associated with root impressions’ identifiability on the geometry of the IB 

was low with blurriness and major loss of traits even with the application of shaders. On the 

texture of the IB and CM models, the identifiability was high as the changes associated with root 

impression appear without loss or distortions of textures. Thus, in this particular case, the traits 

would also have been easily identifiable from photo documentation. 

Similar factors affected the identifiability of the three shallow traits on the surface of the 3D 

models. The shallowness of the sutures and the vessel-like impressions with tiny porosities made 

digitization through laser scanning difficult due to the limitations stated previously. Furthermore, 

the camera could only capture these traits on surface, not geometrically. The methods’ 

limitations thus had a decisive impact on the identifiability of the morphological traits on the 

models. Again, the poisson filter smoothened out the traits on the SB and CM models and 

MeshLab lowered the texture quality of the CM and IB models when they were visualized in the 

software. 
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The scoring system I devised to evaluate and compare the traits proved to be a useful tool, and 

since it is relatively well defined, it makes my results relatable to other studies that decide to 

make the identifiability of traits the standard of evaluation, even if they were to adopt a different 

system. While all qualitative methods are to some extent subjective, osteologists should be able 

to agree to what extent a digital representation of a trait is identifiable in the interpretative 

process. There are however some problems with my grading system. While it may be easy to 

discern cribra orbitalia on a model, the grade of cribra may not be identifiable. Also, the 

identifiability of the traits often fall in between grades. If identifiability is to be used in 

evaluation of 3D models in the future, it is desirable to establish better standards. Furthermore, 

the identifiability rating may be useful to osteologists, but it may not reflect the actual quality of 

the model in other contexts than osteological interpretation. Nevertheless, I believe that my 

results vindicate the idea of using identifiability as a standard of evaluation. Difficulties in 

achieving identifiability cast some doubt on the claims about the capabilities of 3D models in 

previous studies, and highlight the problem of drawing on expertize for evaluation without 

establishing clear standards (Wilson 2013; Errickson et.al. 2014; Bibliowicz et.al. 2011, p. 8). 

The identifiability of the callus formation was also not affected by these factors as it was not 

gradable according to this system, and was evaluated in terms of shape rather than surface 

identifiability. Having visually analyzed the callus formation in different angles on each mode of 

the metatarsal I notice no difference between the models in terms of shape. Overall the 

identifiability of the callus formation on the models was high. The ability to rotate the callus to 

fully appreciate the shapes of the callus is one advantage of 3D documentation that photography 

could never hope to match. Nevertheless, in the case of a callus, this is hardly a factor that could 

impede the identifiability of the trait on a photo. Only when measurements of diameter and 

circumference are of relevance does this shortcoming of photography become an issue. 

Much like the callus formation, the identifiability of the mastoid process and the nasal breadth, 

was not really affected by the factors and issues discussed above as they are metric (measurable) 

traits concerning the scale rather than the texture of the models. With the NextEngine 3D 

scanner, models with highly accurate scale can be obtained, as discussed and stated in various 

studies (e.g. Suleiman et. al. 2012; Cignoni et.al. 2008). However, in order to obtain 

measurements from the IB model of the cranium, the model had to be scaled. Theoretically, this 
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process should give the model accurate scale, but this might differ from reality. The 

measurements of the nasal breadth from the models compared to those taken from the cranium 

showed minor differences of some millimeters. Based on this result, it seems that the 3D models 

have accurate scale. The relative ease by which one can measure 3D models is one important 

advantage over photo documentation, where taking measurements is often more difficult. 

Nevertheless, while differences between the models and their originals were small, amounting to 

1-4 mm, even small differences such as these are significant enough to impact the outcome of 

osteological methodologies designed for use on dry bone. 

Overall, the identifiability of the features was also affected by various factors – the purpose of 

the study, time set and the strategy of the digitalization. The premeditated strategy during the 

scanning and photo acquisition was to capture each specimen in its entirety and thus all of its 

morphological traits. Thus, there was no specific consideration to capture any of the individual 

traits in greater detail. The number of scans and photos also affected the identifiability of the 

traits. The number of scans were limited to three, and set to “high quality”. Initially, I did not 

limit the number of images, but after inspection and sorting, the number of images was 

considerably reduced. However, as the case studies has shown, the number of scans and photos is 

not enough to capture the morphological traits and to generate models with fully identifiable 

traits, especially in terms of the IB models. Extra scans and photos, of the individual traits 

especially, would presumably increase their identifiability but would lead to heavier data, and 

thus require more powerful computer, longer processing time and larger storage space. 

Considering the time constraints customary in commercial settings in cultural heritage, doing 

many scans from many angles is not realistic in most cases. Given this problem, it would be 

advisable for osteologists to plan ahead and purposely attempt to cover the more important traits 

in digitizing the remains, leaving out surfaces less relevant to the osteological interpretation, 

rather than aiming for high overall accuracy, at least with complex specimens such as the 

cranium in this study, where such efforts would likely be time consuming and difficult to 

succeed in even if allowing for heavy models. This supports my contention that osteologists 

should be involved in the digitization process, and that digitization ought not to be left entirely in 

the hands of technicians. 
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To rely on 3D models to substitute for dry bone that have been repatriated or destroyed in 

invasive procedures is not advisable in my view, but when documentation of such remains is 

necessary, I believe that 3D and photo documentation can – to some degree – complement each 

other’s weaknesses. SBMs and CMs have relatively correct scale and geometry and are best able 

to compensate for the weaknesses of photography, while IB models not only require many 

images (i.e. labor as well as weight) to achieve good quality, they have few advantages over 

photo documentation. This is however something that in all probability will change in due time. 

As a singular alternative to photo documentation or for presentation purposes however, IBMs 

and CMs are preferable as correct textures are paramount. Given the complexity of osteological 

analysis, 3D models could never fully substitute for dry bone in educational contexts, but being 

able to interpret 3D models is a skill that in all likelihood will become increasingly important to 

osteologists as technology improves and more specimens are digitized and publicized, and 

something that may need to become an integral part of osteological education and practice.  
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5. CONCLUSION 
In terms of accuracy, the models were not perfect, but exhibited only small differences vis-à-vis 

their originals. Nevertheless, none of the 3D models could represent the morphological traits of 

the cranium and the metatarsal bone fully discernably. Some traits were identifiable on some 

models or in some respect (geometry or texture, or when applying shaders), but overall there 

were considerable distortions and loss of features. Shaders proved to be a very useful tool that 

regularly improved the identifiability of the models, sometimes dramatically so. For serving as 

substitutes to dry bone originals in osteological analysis, 3D models have been shown to have 

both advantages and disadvantages as compared to photo documentation. 

These sobering results reveal that the evaluation of 3D models is a complex and difficult process 

(at the very least, it should be), and decidedly suggest that previous studies have not been 

sufficiently transparent. It would appear that establishing standards for evaluating 3D models is a 

desideratum in digital osteology, since it is simply too difficult to relate the results and methods 

of different studies to one another. One such standard could be a variant on the identifiability 

grading system introduced in this thesis, although it still has much room for improvement.  

Given the rapid advance of digital technology, this may seem rather short sighted, as 3D 

technologies can only improve from here on out, and most of the issues presented here will 

eventually become obsolete as 3D modeling becomes accurate down to the nanometer. Even the 

theoretical issues may become practically moot. Nevertheless, such optimism at this point in 

time may have disastrous consequences. Overconfidence in our own highly flawed 3D 

technologies may lead our future peers to think that our reproductions are more representative of 

their originals than they in fact are, something that may lead to misinterpretation and 

mismeasurement. The more flawed the technology, the more rigorous our practice must be. 
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APPENDICES 

Appendix 1 - Scan-based modeling 
 

1.1 Workflow 
1. First the NextEngine 3D scanner was connected to the laptop. The Auto Drive turntable 

was in turn connected to the scanner also through a cord (fig.1).  

 

 

 

 

 

 

 

 

 

 

  

Figure 1. The scanning set up and instruments used during scanning.  

 

2. The cranium was placed on a donut-shape styrofoam to hold it in place which was in turn 

placed on the Auto Drive turntable during scanning. While the metatarsal bone was 

placed on a small platform with a holder called the PartGripper which also come with the 

scanner (fig.3-4).  

 

3. The ScanStudio HD software which operated the scanner was started and scanning 

activated (fig.2).  
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Figure 2. The toolbar with the green button to start the scanning process with. 

 

4. The chosen name and parameters were entered. The specimen on the platform was 

positioned from the scanner in according with the recommended distance as 

corresponding with the “range” parameter which determines the ideal distance between 

the object and the scanner (fig.3). 

 

 

5. Cranium 

Position: 360  

Division: 12 

Points/ inch: 17k (17 000), HD 

Target: neutral 

Range: wide     

Ideal distance between the scanner and cranium: 17 

inches 

Time: in first position 40 min, second and third 

positions 34 min.  

 

 

 

 

 

Figure 3. Top image: first position – the front. Middle 

image: second position – right side facing down. Bottom 

image: third position – left side facing down.     
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 Metatarsal bone  

Position: 360  

Division: 12 

Points/ inch: 160k (160 000), HD 

Target: neutral 

Range: macro     

Ideal distance between the scanner and cranium: 6, 5 

Time: 40 min in standing position, 34 min in lying 

position. 

  

 

Figure 4. Top image: first position – standing. Bottom 

image – second position – lying. 

 

5. Looking at the window viewer beside the parameter fields the visibility of the object was 

checked by manually rotate the object with the rotating buttons in the toolbar (fig.5) to make 

sure that the whole object is within the rectangular grey box (fig.5) created around the object 

to minimize reduce the time of scanning process.  

 

 

 

Figure 5. The rotating buttons marked with 

red box and a box marked with box.  
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6. Scanning was started with the green start button (fig.6). After each scanning a scan was 

obtained. Each scan was trimmed to remove unnecessary parts (fig.7).  

To select and trim - trimming button> trimming toolbar > plus button to add to selection 

> polygon button to mark > draw around the parts> wait until mark red > check > 

scissor button to remove.  

To unselect parts accidently selected – minus button to subtract from selection> polygon 

selection> draw around the parts > wait until unmark. 

Figure 6. The trimming toolbar which consisted of different tools to trim obtained scan. 

 

 

 

 

 

 

 

 

 

Figure 7. One of the scans of the metatarsal bone model trimmed from unnecessary parts 

such as part of the Autodrive turntable and of the Part Griper to obtained clean scans.   
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7. After all the scans were trimmed, the scans were later aligned one by one (fig.8). The 

first scan was first aligned with the second scan through the distribution of three pins on 

each scan in exact positions (fig.9). The “attach scans” button was pressed after all three 

pins were placed on both scans (fig.8). The same process was repeated until all scans 

were aligned.  

 

Figure 8. The aligning toolbar with the attach (blue box) and aligning button (red box).   

 

 

Figure 9. The alignment of the first two scans of the cranium through distribution of three 

pins.  
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8. The model obtained from the aligning process was saved (toolbar> File> save as> 

name and destination folder > ply format> save). Two copies were created: one being 

kept as backup and the other used in further processing task. 

 

9. The model was then imported into MeshLab 1.3.4BETA (toolbar> File> import 

mesh> choose model in folder >open). Model information concerning the number of 

vertices and faces can be seen at the bottom of the screen in MeshLab (fig. 10).  

 

 

Figure 10. The model of the metatarsal bone from the aligned scans with information 

marked with red box.  
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10. The model of each specimen was processed separately in different MeshLab project 

file where three cleaning filters – Remove Duplicated Vertex, Remove Duplicated Faces 

and Remove Unreferenced Vertex – were applied to remove the noises or unnecessary 

parts from each model (e.g. toolbar > Filters > Cleaning and Repairing > Remove 

Duplicated Vertex). To see the result in terms of the number of e.g. duplicated faces were 

removed (fig.11), the layer dialog was activated (toolbar> View> Show Layer Dialog).  

 

 

Figure 11. The Layer Dialog with the results of the application of cleaning filters within 

the red box.  
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11.After the application of the cleaning filters, each model of each specimen was 

processed (separately) into a water-tight model (fig.12) through the application of the 

poisson filter (Toolbar> Filters> Remeshing, Simplification and Reconstruction> 

Screened Poisson Surface Reconstruction). The filter reduced the size (number of 

vertices and faces), making it easier to process and move in the 3D space. The Poisson 

filter also filled the holes and smoothened the model thus creating a more water-tight 

model of each specimen. However, the water-tight model of each specimen does not have 

a texture as the filter exclude this in the process (fig.12). The water-tight model of each 

specimen was saved and back-up copies were made. 

 

 

 

Figure 12. The water-tight model with the poisson filter dialog box showing the parameters used.   
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Appendix 2 - Image-based modeling 

2.1 Photo acquisition and parameters 
 

1. The cranium and the metatarsal bone were photographed one by one in different 

positions in 360 degrees to obtained overlapping images of each specimen which were 

used to create the IB models. 

  

2. The photo acquisition was conducted in a well lit room. A photo tent was placed on a 

table and two standing lights with softboxes were placed on each side of the table to 

provide soft and even lighting. A Canon EOS 550D digital camera was placed and set on 

a tripod which was adjusted to be high and close enough to be able to capture each 

specimen (fig.13).  

 

Figure 13. Left image: the room and ligthing setup during photo acquisition. 

Right image: the camera used. Bottom right image: the tripod used.  

 

 



83 

 

3. The cranium was placed on a donut-shape styrofoam which was in turn placed on a 

wooden rotating platform when the object was photographed as a whole. However, 

when close up images were taken the cranium needed to be raised. The cranium placed 

on the donut-shaped styrofoam was placed on the Autodrive platform that comes with 

the Nextengine 3D laser scanner, which in turn was placed on the wooden rotating 

platform. The metatarsal bone was placed on the small platform strap on the Part Griper 

and the Autodrive platform which also comes with the scanner (fig.14).  

 

Figure 14. Left image: the cranium on the donut- shape styrofoam that hold it stable on the 

wooden rotating platform. Middle image: the cranium was raised by placing the cranium 

already placed on the styrofoam on the Autodrive platform. Right image: the metatarsal bone 

was held in place with the Part Gripper set on the Autodrive platform.   

 

4. The focus and parameters of the camera were also adjusted depending on the specimen 

and position. However, the parameters were more or less the same for the cranium and 

the metatarsal bone (see below).  

Camera parameters:   

Quality: high 18M 5184x3456 

Metering mode > evaluating metering (with even lighting to capture the object as a whole) 

Metering mode> spot metering (with increased lighting to capture the inside or unlit parts of 

the object). 

Custom white Balance or WB button> image of the white background tent  
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Expo. comp. /AEB or Flash exposure comp. > 0 

ISO Auto > Max 3200 

ISO speed button > 100 

AF button> One-shot AF 

Drive Mode button > Remote control to capture the model as the whole  and to obtain close 

up images.  

Picture Style button> Standard 

AV or Aperture > F14 

5. Each specimen was photographed in different positions.  The cranium was photographed 

in eight different positions – in five positions to capture the whole specimen as a whole 

and in three positions to capture the more inaccessible parts of the cranium (fig.15-16). 

Three different positions were enough to capture the metatarsal bone (fig.17).  

 

 

 

 

 

 

Figure 15. The five different positions which the cranium was photographed in to capture the 

specimen as a whole. 
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Figure 16. The three different positions which the cranium was photographed in to capture the 

more inaccessible parts of the cranium. 

 

Figure 17. The three different positions in which the metatarsal bone was photographed.  

 

2.2 Image-based modeling workflow 
 

1. The overlapping images of each specimen (280 images in case of the cranium and 174 

images of metatarsal images) were later imported into Agisoft PhotoScan projects 

(toolbar> Workflow> Add Photos). Each image was inspected by double clicking on the 

image in the Photo pane. The blurred images were removed from the pool by first 

selecting the image and then clicking on the x button in the Photo pane.  All irrelevant 

elements on the source images (background, foreground and the turntable etc.) were 

masked out to reduce the aligning time (fig.1).  

The Intelligent Scissors tool under “Photo” in the toolbar was used to select most of the 

background by creating a box around the specimen and clicking on the Add to Selection 

button (toolbar>Photo) to mask the object. The mask was inverted by clicking on the 

Invert Mask button to masked the background instead. Furthermore, Magic Wand 
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(toolbar> Photo) was also used to mask uniform background by clicking inside the 

uniform area to be masked. By clicking inside the area again the border of the 

automatically selected area can be change and to mask the area the Add Selection button 

was pressed.   

 

 

  

 Figure 1. Top image: the close up image of the toolbar within the red rectangle. Bottom 

image: a snapshot of the project where one of the cranium images was masked.  The 

black box marking the x button in the Photo pane. 
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2. When all the images were masked the aligning process was conducted (toolbar> 

Workflow> Align Photos) to build a point cloud the first stage of the model(fig.2). The 

masked areas could be ignored during the aligning process by checking “the constrain 

features by mask” option in the “Align Photos” dialog. The parameters used to align the 

images of each specimen are specified in the image below (fig.2). 

 

 

 

 

 

 

Figure 2. A snapshot of the Align Photos dialog window showing the parameters used. 

 

3. Remove the unnecessary and far away points around the point cloud using the trimming 

tools in the toolbar. In the case the free-form selection tool (red box) was used to select 

the points and the Delete selection tool (black box).  

Trim until most of the unnecessary and far away points are removed. Later go to Edit> 

Gradual Selection and set the Criterion in Reprojection Error level (fig.4) demonstrates 

the accuracy of point positioning specified in pixels. According to the Agisoft Technical 

Support it should be below 1 pixel. In this the point cloud of both the cranium and 

metatarsal image-based models consist of points with error below 1 pixel (right click on 

the chunk of the project > Show info> Point Cloud> RMS Reprojection Error) which 

means that a Gradual Selection was not necessary. The procedure is usually applied to 

remove error points with error higher than 1 pixel missed during the manual trimming of 

the point clouds.  If such procedure was needed the slider (fig.4, red box) in the Gradual 
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Selection dialog box was drag until the error points with error higher than 1 pixel around 

the point cloud were selected. Select only the points around the point cloud and not too 

many and not the points that it consists of or else the point cloud become too sparse to 

build a dense cloud of and thus a 3D model of. When the error points were select, the OK 

button was pressed and the Delete Selection button that look like X above the toolbar was 

pressed to delete the error points. Finally, optimize the point cloud by optimizing the 

images (Tools> Optimize Cameras> uncheck “Fit Aspect” and “Fit Skew” since these are 

0 in normal frame cameras).  

 

 

 

 

 

Figure 4. The Gradual Selection dialog box showing with slider marked with red box. 

4. Once the error points were removed control the level of the RMS Reprojection Error 

(right click on the chunk> Show info> Point Cloud> RMS Reprojection Error) to see if 

the level decreased. Repeat the process until the level is 1 pixel or below. Again, do not 

remove too many points and the points that the point cloud consists of or else you might 

end up with too sparse point cloud. The point cloud should be clean until only the points 

that consists it remained (fig.5). 

 

 

 

 

 

 

 

Figure 5. The point clouds of the metatarsal and cranium IB models. 
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5. The cleaned point cloud was later processed into a dense cloud (Menu bar>Workflow> 

Build Dense Cloud). A dense cloud dialog box appears and the parameters (fig.6) were 

set to generate a high quality dense cloud.  

 

 

 

 

  

 

Figure 6. The parameters set to generate a high quality dense cloud. 

 

6. The dense cloud generated was trimmed from unnecessary parts around the dense cloud 

using the Free-form selection and Delete Selection tools above the toolbar. Later the 

dense cloud was processed into a 3D model/ mesh (Workflow> Build Mesh) setting the 

parameters to generate a high quality model (fig.7). 

 

 

 

 

 

 

 

Figure 7. The parameters used to build the model of each specimen. 
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7. Finally, a high quality texture was created (Workflow> Build Texture) applied to the 3D 

model generated using the parameters below (fig.8).  

 

 

 

 

 

 

Figure 8. The parameters used generate the high quality texture.  

The IB models of the cranium and the metatarsal bone are of high quality since the higher the 

quality the higher the chances to capture the morphological traits of interest as much as possible.  

 

 

Appendix 3 – Combined-based model 

3.1 Workflow 
1. Open a project in MeshLab 1.3.3 (older version because alignment can´t be conducted in the 

latest version) and import the scan-based model (File >Import Mesh>find and select the 

model>Open). The model appears without texture due to the application of the poisson filter.  

2. Activate layer dialog (View>Show Layer Dialog) and visualize the model in bounding box 

mode (transparent box button beside the model in the layer dialog) which will make the 

alignment process easier especially with large size models. The imported model disappears and 

the bounding box appears. In the layer dialog the model is still visible (shown by the eye symbol 

beside its name) though not digitally visualize.  
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3.  Import the image-based model (File>Import Mesh>find and select the model>Open) and 

activate the bounding box mode as well (transparent box button beside the model in the layer 

dialog). 

4. Click on the image-based model to choose the layer (turns yellow) and click on the yellow A 

button on the toolbar which activate the alignment tool (or activate through Edit>Align).  

5. Click on the image-based model´s layer in the alignment window and click on “Glue Here 

Mesh” button (fig.1). A star symbol next to the image -based model layer appear marking it as 

the main model for alignment. 

 

Figure 1. The aligning procedure of the IB and SB model in MeshLab. 

6. Click on the scan-based model and click on “Point Based Glueing” option to glue the model to 

the main model. 

7. The alignment window appears depicting both models side by side. Check the “Allow 

Scaling” box before alignment to be able to scale the scan-based model (bigger in size) down to 

the size of the image-based model.  
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8. Distribute 6-8 pins on each model placing each pin on the same position on both models. Place 

the pins on identifiable landmarks on the models (fig.2). Do not place the pins too close to each 

other, or on fragmented surface or at the very edge. This could result to poorly aligned models or 

failure in the alignment.  

Figure 2. The IB and SB model being aligned through distribution of pins. 

 

9. When all pins are distributed the models are automatically aligned. Click on the “Ok” button 

to close the alignment window.  

10. Check alignment result by visualizing both models (Layer dialog>cylindrical button located 

second to the right of the layer dialog for smooth mode). A model with texture and white patches 

appears as the models are position at the positioned at the exact same. If the model appears 

poorly aligned (identifiable seams or parts of the models are still in different positions) realigned 

the models again repeating the same process above. 
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11. Activate bounding box mode again for both models and make a copy of it (Duplicate Current 

Mesh) by right clicking on its layer in the Layer Dialog. Freeze it in its current position (Freeze 

Current Matrix) by right clicking on the layer of the copy model (fig.3).  

 

 

 

 

 

 

 

 

 

 

Figure 3. The obtained cranium model aligning the IB and SB models. The model was freeze in 

position.  

 

12. Click on the copy and export it under a different name in obj. format (File> Export Mesh 

As> select folder to save in > name your model> choose format in this case obj.> Save). Do not 

close the MeshLab project. 

13. Open the project where the image-based model was created in Agisoft PhotoScan and import 

(Tools> Import> Import Mesh> choose the model> open) the copy of the scan-based model 

from the alignment. The copy model replaces the image-based model in the project. The copy 

appears without texture and in the same scale as the image-based model it replaces (fig.4). 
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Figure 4. The obtained model imported into the same Agisoft project where the IB model was 

created and stored. 

  

14. The texture is thus applied (Workflow>Build Texture). A small window appears with texture 

parameters option. Set the parameters according to the desired texture quality and click on the 

“Ok” button. In this case the parameters below were applied: 

Mapping mode: Generic 

Blending mode: Mosaic 

Texture size/count: 5000x4 

Advanced: Enable color correction: disabled 

 15. After the texture was applied export the model under a new name (File> Export 

Model>select folder> name model> choose format in this case ply.>Save). 

16. Import (File>Import Mesh> find and select model> Open) the model back to MeshLab in 

the same project where the models aligned were. To visualize the model, make the other 

invisible by closing the eyes buttons beside the other models layers in the Layer Dialog. The 

model appears with texture built in Agisoft project. Check and note the texture size of the model 

stated in the Layer Dialog.  
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17. Since the model was imported back into same MeshLab project additional alignment is 

required. This time the original SB model was used as main and all the other models were 

aligned to the main model. First the SB model was chosen in the Dialog layer and the model was 

exported (File> Export Mesh As>select folder to save> name the model> save) to obtain the 

final model. 

18. Import (File>Import mesh> search and select the model> open) it in a new MeshLab project 

to check it. The model should appear with textures but the textures might be a bit dark, thus 

visualize the textures per face (Render>Color>Per Face). Import the original poisson (scan-

based) model to compare the number of vertices and faces. Click on each and note these 

variables specified at the bottom of the MeshLab screen. Compare the result and if both have the 

same number of vertices and faces, it means that they have the same scale. Hence the final model 

has texture and accurate scale. 

If you are interested of the 3D models, scan and image data used in this thesis or have questions 

feel free to contact me at ark10bpl@student.lu.se 

Resources 
Agisoft (low-cost image-based modeling software) 

Website: http://www.agisoft.com/  

Software license: http://www.agisoft.com/buy/licensing-options/  

Manuals: http://www.agisoft.com/downloads/user-manuals/  

MeshLab (open source) 

Website: http://meshlab.sourceforge.net/  

Video tutorials: https://www.youtube.com/user/MrPMeshLabTutorials  

Manual: google “MeshLab documentation” to find the manual in PDF 

 

Cloud Compare (open source) 

Website and tutorials: http://www.danielgm.net/cc/ 

Manuals and documentation: 

http://www.cloudcompare.org/doc/wiki/index.php?title=Main_Page 

 

Nextengine 3D Scanner Ultra HD (low-cost 3D laser scanner) 

Website: http://www.nextengine.com/  

 

http://www.agisoft.com/
http://www.agisoft.com/buy/licensing-options/
http://www.agisoft.com/downloads/user-manuals/
http://meshlab.sourceforge.net/
https://www.youtube.com/user/MrPMeshLabTutorials
http://www.danielgm.net/cc/
http://www.cloudcompare.org/doc/wiki/index.php?title=Main_Page
http://www.nextengine.com/
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